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OverviewOverview

• Lean Six Sigma and Why

• Principles and Tools

• OSD CPI/LSS Charter
DepSecDef memo of 11 May 2006

DepSecDef memo of 30 April 2007

DoDD 5010.42 15 May 2008

• Performance Excellence… A Lean Six Sigma World-Class 
Methodology

• Where to Start…Voice of the Customer 
Projects Prioritized to Strategic Plan
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Right Training. Right Attitude.Right Training. Right Attitude.

• Lean Six Sigma is not rocket science… you can do this

• Lean Six Sigma is not “easy”… it requires dedication and effort

Lean Six Sigma
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Foundation to Lean 6 SigmaFoundation to Lean 6 Sigma

-Dr. Mikel Harry
Motorola

If you cannot express what you know in numbers,
you don’t know much about it;

If you don’t know much about it, 
then you can’t control it;

If you can’t control it, 
you are at the mercy of chance.
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Foundation to Lean 6 SigmaFoundation to Lean 6 Sigma

Definitions of Insanity:

Doing the same thing over and over 
and expecting a different outcome!

AND

Using the same logic to get out of the 
trouble that got you there in the first 
place!

-Albert Einstein
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Continuous ImprovementContinuous Improvement

• A framework for constantly improving organizational 
performance

• Provides steady, incremental improvement in everything 
we do to meet/exceed changing expectations:

Better quality
Faster turnaround
Lower costs
More responsive service

• A relentless, never-ending process

• Requires that we all change the way we think, talk, work, 
and act
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AA BB CC DD EEL1

L2

L3
Customer Customer

DA DB DC DD DE

What is Lean?What is Lean?

Action Officers

SES Level

Staff Director

Lean Six Sigma
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What Is Six Sigma?What Is Six Sigma?

Too much variation Hard to produce output 
within customer 
requirements 
(specifications)

Low sigma values (0–2)

Moderate variation Most output meets 
customer requirements

Middle sigma values  
(2–4.5)

Very little variation Virtually all output meets 
customer requirements 

High
(4.5–6)

sigma values 

• Sigma (or σ) is a statistical 
concept that represents how 
much variation there is in a 
process relative to customer 
specifications

Sigma
?

σ?
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Why Aim as High as Why Aim as High as 66 Sigma?Sigma?

Even at 99% quality (equivalent to a sigma level of 3.8),
there would be:

• Unsafe drinking water almost 10 hours each month

• At least 200,000 wrong drug prescriptions per year

• Two short or long landings at O’Hare airport each day

• Over 90,000 wrong felony convictions per year

• 20,000 lost or incorrectly delivered articles of mail per hour

Lean Six Sigma
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The Look of 6The Look of 6σσ PerformancePerformance

99%
Good

99.99966%
Good

20,000

5,000

200,000

7 hr 
per month

Lost articles of mail per hour 7

Incorrect surgeries per wk 1.7

Wrong prescriptions each yr 68

Hours without electricity 1 hr
per 34 years
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Measures of PerformanceMeasures of Performance

Time

n

X
X

n

i

i∑
== 1
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Standard DeviationStandard Deviation
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Exercise 1AExercise 1A

Purchase Requests Processed 
 Army Navy 

Mon 89 91 
Tue 70 102 
Wed 100 103 
Thur 121 105 
Fri 120 99 

X    
 

 

What can we say about the performance of these two 
Services with respect to their means?

Lean Six Sigma
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Exercise 1AExercise 1A

The Services are equal in performance, 
but is there more to the story?

Purchase Requests Processed 
 Army Navy 

Mon 89 91 
Tue 70 102 
Wed 100 103 
Thur 121 105 
Fri 120 99 

X    
 

 

100 100
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Exercise 1BExercise 1B

What can we say about the performance variation
of these two Services?

Purchase Requests Processed 
 Army Navy 

Mon 89 91 
Tue 70 102 
Wed 100 103 
Thur 121 105 
Fri 120 99 

σ   
 

 

Lean Six Sigma
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Purchase Requests Processed 
 Army Navy 

Mon 89 91 
Tue 70 102 
Wed 100 103 
Thur 121 105 
Fri 120 99 

σ   
 

 

Exercise 1BExercise 1B

Army is much more varied.  
What are the implications?  

21.6 5.5
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Sigma LevelSigma Level

• Sigma Level (or Z-value): the number of Sigma between the 
process mean and the nearest specification limit

Mean
1σ 2σ 3σ 4σ 5σ-3σ -2σ -1σ

Target

If we know:
The Mean of the process +
The σ of the process + 
The Specifications set by 
the customer

Then:
We can determine the Sigma 
Level of the process

Lean Six Sigma
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A 3A 3σσ ProcessProcess

-6σ -5σ -4σ -3σ -2σ -1σ 1σ 2σ 3σ 4σ 5σ 6σ

MeanLSL USL

Mean
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A 6A 6σσ ProcessProcess

-6σ -5σ -4σ -3σ -2σ -1σ 1σ 2σ 3σ 4σ 5σ 6σMean

MeanLSL USL

Lean Six Sigma
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ExampleExample

Mean

1σ 2σ 3σ 4σ 5σ 6σ-3σ -2σ -1σ

USLLSL

7σ 8σ 9σ

• What is the sigma level of this process?
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ExampleExample

Mean

1σ 2σ 3σ 4σ 5σ 6σ-3σ -2σ -1σ

USLLSL

7σ 8σ 9σ

USL - Mean = 9σ

Lean Six Sigma
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ExampleExample

Mean

1σ 2σ 3σ 4σ 5σ 6σ-3σ -2σ -1σ

USLLSL

7σ 8σ 9σ

Mean - LSL = 3σ
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ExampleExample

Mean

1σ 2σ 3σ 4σ 5σ 6σ-3σ -2σ -1σ

USLLSL

7σ 8σ 9σ

• The “Process Sigma” is:
• The lesser of (USL-Mean) & (Mean-LSL) stated in units of σ

Lean Six Sigma
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Sigma Level FormulaSigma Level Formula

• The Sigma level of a process is the lesser of:

σ
XUSL −

σ
LSLX −

or
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Measures of PerformanceMeasures of Performance

• Recall the Army and Navy 
processing rates

Assume: 
LSL = 70 documents per day

to keep up with incoming rate
USL = 130 documents per day 

To keep from “overfeeding” the 
processor which would result in 
a higher error rate

What are the sigma levels for 
each of these? 
What are the implications?

Purchase Requests Processed 
 Army Navy 

Mon 89 91 
Tue 70 102 
Wed 100 103 
Thur 121 105 
Fri 120 99 

σ   
 

 

21.6 5.5
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Measures of PerformanceMeasures of Performance

4.1
6.21
100130

=
−

=
−

σ
XUSL

4.1
6.21
70100

=
−

=
−
σ
LSLX

Lower Sigma Level:

Sigma Level: 1.4

Upper Sigma Level:

5.5
5.5
100130

=
−

=
−

σ
XUSL

5.5
5.5
70100

=
−

=
−
σ
LSLX

Sigma Level: 5.5

Upper Sigma Level:

Lower Sigma Level:

A R M Y   N A V Y   
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Which would you prefer?Which would you prefer?

-6σ -5σ -4σ -3σ -2σ -1σ 1σ 2σ 3σ 4σ 5σ 6σMean

MeanLSL USL

-6σ -5σ -4σ -3σ -2σ -1σ 1σ 2σ 3σ 4σ 5σ 6σMean

MeanLSL USL

The target is missed 
more than 15% of 
the time

The target is usually 
never missed?

A R M Y

N A V Y 
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• Continuous Process Improvement (CPI) is a deliberate 
change in Process Performance

Highly 
Variable 
Process

Gain Control, 
Lean and Stabilize 

the Process

Shift the 
Process 

Performance

A Program of Process ImprovementA Program of Process Improvement
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Target USLLSL

Customer SpecificationsCustomer Specifications

• The specification limits 
represent the parameters of 
performance desired by the 
customer.

• The Upper Spec Limit (USL) 
& Lower Spec Limit (LSL) 
represent the level of 
tolerance around this desired 
target.

• Together, they represent 
what the customer wants! 
Not what the process does.

Lean Six Sigma
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Different Sigma Process LevelsDifferent Sigma Process Levels

-6σ-5σ-4σ -3σ-2σ -1σ 1σ 2σ 3σ 4σ 5σ 6σ

MeanLSL USL
-6σ-5σ-4σ-3σ-2σ-1σ 1σ 2σ 3σ 4σ 5σ 6σ

MeanLSL USL

6σ Process

3σ Process
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Defects Defects

Too early Too late

Delivery Time

Reduce 
variation

Delivery Time

Too early Too late

Spread of variation 
too wide compared 

to specifications

Spread of variation 
narrow compared to 

specifications

Importance of Reducing Importance of Reducing VariationVariation

• To increase a process sigma level, you have to decrease 
variation.

• Less variation provides:
Greater reliability in the process
Less waste and rework, which lowers costs
Products and services that perform better and last longer
Happier customers

Lean Six Sigma
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Measures of PerformanceMeasures of Performance

• If we know the process mean and the process sigma, then we 
can describe the performance of the process. 

• But:
How do we know if the process performance is good or bad?
Who should determine if performance is good enough?

?
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Additional Metrics of Six SigmaAdditional Metrics of Six Sigma

• In addition to Sigma Level, four other performance metrics  are 
of interest:

Defects Per Unit (DPU)
Process Capability
Defects Per Million Opportunities (DPMO)
Yield

• If you know one…
you can determine the others

Suduko

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
34 UNCLASSIFIED

ObjectivesObjectives

Current State Objective

The mean is on target, but 
the spread is wider than the 
specification range.

Focus on reducing process 
variation while maintaining 
the mean at target. 

The mean is not centered, 
but the spread is narrower 
than the specification range. 

Focus on shifting the mean 
to target, while maintaining 
or reducing process 
variation. 

The mean is not centered 
and the spread is wider than 
the specification range. 

Focus on shifting the mean 
to target AND reducing 
process variation. 

The mean is centered and 
the spread is narrower than 
the specification range. 

Use control procedures to 
maintain the mean and 
process variation.

Target USLLSL
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Foundation to 6 SigmaFoundation to 6 Sigma

Y = f(x)Y = f(x)Y = f(x)
Y is: Xs are:
Output Inputs
Dependent Independent
Observed Controlled
Effect Causes
Result Reason

Lean Six Sigma
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ImprovementImprovement--Focused ScaleFocused Scale

DPMO σ

308,537 2

66,807 3

6,210 4 

233 5

3.4 6
Process

Capability
Defects per

Million
Opportunities

(distribution shifted ±1.5s) 

Increase in 
Sigma 

requires 
exponential 

defect 
reduction

“trim the fat”
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Why Use Six Sigma As a Metric?Why Use Six Sigma As a Metric?

Process # of Transactions 
per month

Performance

Calls handled  14,000  10% require transfers 

Credits processed  75  Avg. cycle time of 3 days 

Installation of new service  2500  94% first-time through rate

Daily reports  28-31  9 errors per day

• Focuses on defects
Even one defect reflects a failure in your customer’s eyes

• Using a common metric makes comparisons easier 
For instance, which of the following processes performed best?

Lean Six Sigma
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The History of CPI/Lean Six SigmaThe History of CPI/Lean Six Sigma

• Frederick W. Taylor in 1880s and early 1900s
Taylor’s systematic study of workers’ use of time and motion prefigured 
Walter Shewhart’s application of statistical methods to control 
manufacturing quality

• World War I
Application of mathematics to problems of production and quality
control helped decrease failure rate
Management became interested in continuing quality control programs 
after the war

• W.E. Deming and Joseph Juran took quality control to Japan in 
1953. The 1960s saw a surge in the growth of quality in Japan

• In the 1980s, the NBC White Paper “If Japan Can… Why can’t We”
sparked increased interest in quality and total quality management
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The History of 6 SigmaThe History of 6 Sigma

• Mid-1980s Motorola started “6 Sigma”
Focused on creating strategies to reduce defects in own products
Discovered that problems with high first-pass yield (the amount of products 
that make it through defect-free) seldom failed in use
Won Baldrige Award 1988

• Led by Mikel Harry, Motorola partnered with IBM, ABB (Asea Brown
Boveri), Texas Instruments, Allied Signal, and Kodak to found the “Six 
Sigma Research Institute”

Late 1990s, Mikel Harry began commercializing 6 Sigma and successfully 
applied its techniques to a non-manufacturing environment

• Current popularity due in part to publicity of General Electric’s former 
CEO Jack Welch’s commitment to achieving 6 Sigma capability

Lean Six Sigma
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• Applicable to EVERY Business 
Function

Traditional manufacturing
Transactional processes

• Any process that produces an 
output has downstream 
“customers” (external or internal)

Versatility 

Services

Administration

Quality
Assurance

Maintenance

Manufacturing

Purchasing

Design

Six
Sigma
Method
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2000

Why Use Lean Six SigmaWhy Use Lean Six Sigma

• LSS is the CPI industry standard
Increase throughput
Shorten cycle times
Reduce defects
Lower costs 

1992 1995 Today

Motorola
ABB
TI
IBM
DEC
Kodak 
AlliedSignal
GE

Siebe Foxboro 
Lockheed Martin 
Bombardier
John Deere
Whirlpool
GenCorp
Nokia
Sony 

Siemens
Compaq
Seagate
PACCAR
Toshiba
DuPont
Dow Chemical

Maytag
Praxair
Ford
Air Products
Honeywell
Johnson Controls
Johnson & Johnson

Fannie Mae
Bank Of America
Intuit
AXA Equitable
United Health Group
Cardinal Health
Blue Cross
Providence Health
Home Depot

US DoD
Wells Fargo
Robert Half
Fifth Third Bank
CitiGroup 

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
42 UNCLASSIFIED

Where Are Businesses Today?Where Are Businesses Today?

Experts think most 
businesses fall 
between 3 - 4 sigma

DPMO
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Lean Six Sigma PrinciplesLean Six Sigma Principles

• Identify value in the eyes of the Customer
Learn to see your processes from the perspective of your customer

• Identify the value stream and eliminate waste/variation

• Make value flow at the pull of the customer

• Involve, align, and empower employees
Develop solutions using the people who are currently working in the 
process

• Continuously improve knowledge in pursuit of perfection

Lean Six Sigma
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• In Improvement…
identify the key Xs to reduce variation in the Y

• In Design…
carefully set specifications on the Xs so that we get the desired Y

• In Process Management…
monitor and control the Xs to assure we will get the desired Y

Identify & Control the XsIdentify & Control the Xs

y  =   f (x1, x2, …)

process output is key process and input factors
that cause variation in the outputa function of
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Overview of DMAICOverview of DMAIC

1

2

3

4

5
DEFINE

MEASURE

ANALYZE

IMPROVE

CONTROL

Lean Six Sigma
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The Six Sigma TollgateThe Six Sigma Tollgate

Project Charter
Problem Statement
Defined Benefits
Business Case

Process Map Potential Xs “To Be” Process Map Transition Plan

Measurable Y
Customer Specs/VOC

Data Collection Plan
Data Collected

Critical Xs Improvement Strategy
Improvement Model
“X” Improvement Target

QC Chart

Cross Functional Team Data Presentation
Run Chart; Histogram; 

Mean/Stand. Dev.

Required Data Display:
Pareto Charts; Fish 

Bone / C&E; Histograms; 

Mistake-Proofing Communication to 
Impacted Areas

Timeline Updated CTQs/CTPs Optional Data Display: 
Descriptive Stats.; 

Time Series Plots; 
Control Charts; Box Plots

FMEA Project Documentation

SIPOC “Y” Performance Target XY Matrix Risk Analysis & Risk 
Mitigation Plan

I accept the Define 
Tollgate. Signed:

I accept the Measure
Tollgate. Signed:

I accept the Analyze 
Tollgate. Signed:

I accept the Improve 
Tollgate. Signed:

I accept the Control
Tollgate. Signed:

(Sponsor) (Sponsor) (Sponsor) (Sponsor) (Sponsor)

(Process Owner) (Process Owner) (Process Owner) (Process Owner) (Process Owner)

(MBB) (MBB) (MBB) (MBB) (MBB)

(Finance Owner) (Finance Owner) (Finance Owner)

Define Measure Analyze Improve Control
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• Change Agents for the way we do business

• OSD’s full-time CPI/LSS Program Office
Lean Six Sigma methodology
OSD training, testing, and certifying Green Belts and Black Belts
In-house capability, ownership

• Reporting and Metric Development
Centralized oversight for reporting and metrics

• Regularly scheduled updates to the Senior Steering Committee

• Assist and Support OSD Performance Management efforts
Habitual relationship with CPI/LSS personnel

The Role of Performance ManagementThe Role of Performance Management

Lean Six Sigma
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The Lean Six Sigma CadreThe Lean Six Sigma Cadre

• Green Belt 
Researcher, Data Analyzer, Team leader

• Champion 
Executive-level Sponsor/Supporter

• Senior Steering Committee
OSD, Service, Agency, Activities Reps

• Master Black Belt 
Manages deployment of several Black Belts and 
mentors  Black Belts/ Green Belts

• Black Belt 
Works Lean Six Sigma Full-time 
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Six Sigma Certification RequirementsSix Sigma Certification Requirements

Training Testing Projects Mentoring Other 
Green 
Belt

Black 
Belt

• 160 hrs BB 
classroom 
instruction 
(includes previous 
GB instruction 
plus 120 hrs DoD 
BB instruction)

• Pass BB test • 2 BB level projects 
with measurable 
improvement 
results 

• Signed Tollgates 

• Mentor 2 GBs
to project 
completion 

• Instruct GB 
Course

• Approval from 
Certification 
Review Board

Master 
Black 
Belt

• Black Belt 
Certification 

• None • Complete 2 high-
impact projects with 
measurable 
improvement 
results 

• Signed Tollgates 

• Mentor 5 GBs
to project 
completion 

• Mentor 4 BBs
to project 
completion 

• Instruct BB 
Course

• Approval from 
Certification 
Review Board 

• 40 hrs GB 
classroom 
instruction

• Pass GB test • Complete 1 GB 
project with 
measurable 
improvement 
results 

• Signed Tollgates 

• None • Approval from 
Certification 
Review Board 

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
50 UNCLASSIFIED

Exercise: CatapultExercise: Catapult

• Break up into teams of approx. 5 members
• Assemble and fire catapult
• Record results
• Time limit: 5 minutes



OSD Greenbelt - UNCLASSIFIED 26

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
51 UNCLASSIFIED

Exercise: Catapult PerformanceExercise: Catapult Performance

Group # Name

Test Launch

Distance 1

Variance from Center 1

Distance 2

Variance from Center 2

Distance 3

Variance from Center 3

Distance 4

Variance from Center 4

Distance 5

Variance from Center 5

Total

Mean/Average

Median

Sigma

Lean Six Sigma
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Exercise: CatapultExercise: Catapult

• Did any team perform exactly alike?

• Note any differences among teams

• Discuss possible reasons for 
differences
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The harvest is plentiful but the workers are few

Questions?

Lean Six Sigma
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Define
Define

Measure

Analyze

Improve

Control

Lean Six Sigma
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Catapult Customer

• Who is the customer of the catapult you just fired?

• Will your catapult meet customer spec’s?
What does the customer want?
What is the objective?
What might the customer have wanted the catapult to do? 

• Might knowing this information give you ideas on how you should 
have fired your catapult?
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DefineDefine

• Who is the customer for your project?
Are they Internal, External, or Both?

• What is required of you for your project?
??

Lean Six Sigma
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Problem StatementProblem Statement

• OSD Policy:
Financial benefit yielded from project remains with 
the process owner
Project benefit is determined by the Champion

Benefit must be measurable

• The problem statement should:
Focus everyone involved on the deficiency at hand
Quantify the deficiency in terms of performance 
or customer satisfaction
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Project BenefitsProject Benefits

• Project benefits can come in 
many forms:

Financial savings 
Cost Avoidance
Productivity Improvements
Throughput improvement
On Time Delivery
Labor reductions
Customer Satisfaction
Defect Elimination
Accuracy Improvement
Error Reduction

Lean Six Sigma
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Problem Statement: Example 1Problem Statement: Example 1

In 2006, 70% of all purchase requests 
submitted contained errors.

In 2006, 70% of all purchase requests 
submitted contained errors.

Errors result in double-processing that 
adds work hours (cost) and processing 
delays.

Update your problem 
statement as you 

uncover more  
details about the 

problem



OSD Greenbelt - UNCLASSIFIED 32

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
63 UNCLASSIFIED

• Often people think tackling a broad problem can make big 
improvements

“Let’s tackle the elephant”
“Solve world hunger”
“Boil the ocean”

• This usually backfires because 
it’s easy to get bogged down 
taking on too much at once

• It is more effective to focus on a specific component of                       
a problem

Define The ProjectDefine The Project
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Define the ProjectDefine the Project

• A poorly focused 
problem statement does 
not answer as many 
questions as a well 
focused problem 
statement

• Focus a problem 
statement by answering 
who, what, where, when, 
and which

Broad or
Vague

Somewhat 
Focused

Narrow
Focus

xPoor service at the 
Pentagon

Poor service at the 
Pentagon Badge 
Office in the afternoon

Slow service 
obtaining CAC cards 
between 2pm and 
4pm on weekdays at 
Pentagon Badge 
Office

What: poor service

What: poor service
Where in the Pentagon: Badge Office
When: afternoon

What: Poor service
What type of service: CAC card
What about the service: It is slow
When is the problem the greatest:
Between 2pm and 4pm on weekdays

Broad or
Vague

Somewhat 
Focused

Narrow
Focus

Broad or
Vague

Somewhat 
Focused

Narrow
Focus

x

x
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Charter & TimelineCharter & Timeline

Charter
Problem 
Statement:
Business 
Case:

Unit:

Customer 
Specifications:

Measure Stop:
Measure Start:

Defect:

Scope:
Timeline

Phase Planned Actual Status

Define dd mm yy dd mm yy

Measure dd mm yy

Analyze dd mm yy

Improve dd mm yy

Control dd mm yy

Take away 
message goes 

here
(impact of 
problem)

- B -
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Charter & TimelineCharter & Timeline

Charter
Problem 
Statement:

What is the problem 

Business 
Case:

• What benefits will be achieved as a result of the 
project

Unit: How is an action identified -

Customer 
Specifications:

Defines what the customer considers to be good/poor 
performance

Measure Stop: Defines when a unit is considered complete
Measure Start: Defines when a unit starts

Defect: • Describes an unacceptable unit

Scope: Defines the organization or area where process 
resides.  

Timeline
Phase Planned Actual Status

Define dd mm yy dd mm yy

Measure dd mm yy

Analyze dd mm yy

Improve dd mm yy

Control dd mm yy

Take away 
message goes 

here
(impact of 
problem)

- B -
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Define the Project Define the Project -- QFR Response ProcessQFR Response Process

Charter

Problem 
Statement:

Questions For the Record (QFRs) from Congress are not being 
answered in a timely manner.

Business 
Case:

As a result of this project, we will:
Decrease QFR response time to within 30 days
Streamline the current QFR/IFR (Question for the Record/Insert for 
the Record) process and promulgate a written procedure that can 
be effectively used by all component organizations
Ensure coordination chops are obtained at the optimal steps in the 
process

Customer 
Specs:

DoD has 30 days from receipt of QFR/IFR to return a response to 
Congress.

Defect: Responses that exceed 30 days

Unit: Individual QFRs.  For the purposes of this review, only QFRs will be 
evaluated, as they are the bulk of the actions being tracked.

Start: Upon receipt by DoD Legislative Affairs

Stop: Upon LA transmission of response back to Congress
Scope: All LA-processed QFRs submitted in Calendar Year 2007 up to and 

including those sent to committee as of 30 November 2007, with 
detailed tracking of QFRs assigned to AT&L and Policy.

Faster 
responsiveness 

to 
Congressional 

QFRs will 
improve our 
relationship 

with Congress
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Define the Project Define the Project –– PRD/PRS Congressional Reply ProcessPRD/PRS Congressional Reply Process

Charter

Problem 
Statement:

Replies to letters from Congressmen/Senators for DEPSECDEF and 
SECDEF signature (PRD/PRS) are not being answered in a timely 
manner. 

Business 
Case:

As a result of this project, we will:
Decrease PRD/PRS Congressional response time to 7 days
Establish PRD/PRS Congressional standard processing business 
rules that can be effectively used by all component organizations
Ensure coordination chops obtained at optimal steps in the 
process

Customer 
Specs:

Per SECDEF, DoD has 7 days from receipt of a PRD/PRS 
Congressional to return a response to Congress.

Defect: Responses that exceed 7 days

Unit: Individual PRD/PRS Congressional replies.  For the purposes of this 
review, only QFRs will be evaluated, as they are the bulk of the 
actions being tracked.

Start: Upon receipt by DoD Executive Services Division (ESD)

Stop: Upon ESD delivery to Congress
Scope: All PRD/PRS Congressional replies generated in Calendar Year 2007 

up to and including 30 September 2007, with detailed tracking of
QFRs to AT&L and Policy.

Faster 
responsiveness 

to 
Congressional 

letters will 
improve our 
relationship 

with Congress
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Define ToolsDefine Tools

• Customer Research such as 
interviews, focus groups, surveys

• Pareto Chart (s) depicting why the 
project is important to the customer

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
70 UNCLASSIFIED

DefineDefine

ProcessInputs Outputs

Suppliers

Customers

“SIPOC”

Suppliers     Inputs     Process     Outputs     Customers

Before we stumble around someone’s sandbox, 
…shouldn’t we know something about the sandbox?
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S upplier: A person or organization that provides 
the inputs to your process.

I
P
O
C

nput: Materials, resources, and data required 
to execute your process.

rocess:
A collection of activities that takes one 
or more kinds of input and creates one 
or more kinds of output that is of value 
to the customer.

utput:
Tangible products or services that 
result from the process -should satisfy 
customer need.

ustomer:
A person or organization who receives 
the outputs of your process -internal or 
external.

SIPOCSIPOC

• A SIPOCSIPOC is a framework used to construct a 
high-level map of a process

Lean Six Sigma
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PPSS II OO CC

Elements of a SIPOCElements of a SIPOC

Suppliers Inputs Process Outputs Customers

Process
Map
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What are What are CTQsCTQs??

• CTQ = “Critical To Quality” characteristics
Measurable characteristics of a product or process 
Imply performance standards that must be met to satisfy the 
customer

• Role of CTQs in your project 
Ensure that your project is directly linked to a critical issue 
affecting customer satisfaction
Typically focus on 1 or 2 CTQs
The basis for project success

Lean Six Sigma
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Other SIPOC UsesOther SIPOC Uses

PPSS II OO CC
Suppliers Inputs Process Outputs Customers

CTQ

Customer Needs
= Big Ys
= “VOC”

Small Ys

Candidate Xs

“Vital Few” Xs

Suppliers and Inputs help 
identify potential upstream Xs
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Why develop a SIPOC in the DEFINE Phase?Why develop a SIPOC in the DEFINE Phase?

PPSS II OO CC
Suppliers Inputs Process Outputs Customers

The 
OUTPUTS 

lead to 
potential 
metrics

The PROCESS 
defines the 

BOUNDARIES for 
project scope and 
documents “how 

things work”

Each OUTPUT 
should have 
one or more 

CTQ
CTQ

Customer Needs
= Big Ys
= “VOC”

Outputs Y
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1. Name the Process
• Agree on beginning and end (boundaries)

2. Specify primary Outputs and the Customers receiving them
• Use nouns for outputs (e.g., Intel report, training, etc.)
• Use adjectives for CTQs (e.g., timely, knowledgeable, accurate, etc.)

3. Document the steps in the  Process
• Brainstorm with the whole team
• Write each process step on a separate post-in note and post on wall

• Begin all steps with a verb
• Don't try to establish order yet
• Don’t get lost in the details of each step

4. Identify critical Inputs which affect the quality of the process

5. Identify the Supplier who provides each input

6. Validate that the map represent how things actually work today
• Not how you think it is
• Not how it should be

Steps to Build a SIPOC MapSteps to Build a SIPOC Map
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High Level Process MapHigh Level Process Map

Family

Dealers

Bank • Loan details

• Purchased car
• Secured Loan

• Me 
• Family

• Requirements
• Family needs
• Budget

• Specs
• Prices
• Availability

Negotiate w/dealer

Pick up car

Determine purchase 
options

Visit dealers; identify 
best deals

Review data

Agree on best option

Secure loan

(Use Verbs) (Use Nouns)(Use Nouns)

PPSS II OO CC

Lean Six Sigma
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CTQ Flow DownCTQ Flow Down

CTQ = “Critical to Quality”
Key measurable characteristics that must be met in 
order to satisfy the customer

Process outputs that directly relate to the CTQ. 
(Specifications for these outputs determine 
“defects”)

Process inputs, controls, and factors that 
potentially impact the Project Y

Xs that can be adjusted to achieve Six Sigma 
performance

“Voice of the Customer” (VOC)

CTQ

Customer Needs
= Big Ys
= “VOC”

Small Ys

Candidate Xs

“Vital Few” Xs

Begin with customer needs and Begin with customer needs and ““flow downflow down”” to Xsto Xs
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Determining Customer NeedsDetermining Customer Needs

• Customer Interview
Important information gathering 
technique to identify and 
understand customer needs
Able to ask follow-up questions 
to gather more complete and 
useful feedback
Fosters cooperative working 
relationships between customer 
and supplier
Must be well planned
Customers can be internal or 
external

Lean Six Sigma
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Customer Interview ProcedureCustomer Interview Procedure

• Before the Interview:
Gather background information
Outline areas to be covered and major questions to be asked:

Open-ended questions
Who, What, Where, When, Why, and How

Choose a comfortable meeting place

• During the Interview:
Help interviewee feel comfortable
Tell interviewee the purpose and proposed length of the 
interview
Remain analytical and objective
Take notes
Summarize and reflect back answers to verify what you learned

• After the Interview:
Thank the interviewee
Review and interpret data as soon as possible
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Interview SuggestionsInterview Suggestions

• Ask:
“What barriers do you face in doing …?”
“What issues do you encounter when …?”
“What are the main issues as they relate to …?”
“In an ideal world, what would you improve?”
“Why is that true?”
“Tell me more about that.”
“Give me an example.”
Open-ended questions

• Listen!
Conduct the interview so that the interviewee feels 
like the customer

Lean Six Sigma
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Likert ScaleLikert Scale

• Likert Scale
A rating scale measuring the strength of agreement with a clear 
statement
Often administered in the form of a questionnaire used to gauge attitudes 
or reactions
Example:

"I found the software easy to use..."

A.  Strongly disagree
B.  Somewhat disagree
C.  Neither disagree nor agree
D.  Somewhat agree
E.  Strongly agree
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SurveysSurveys

• In these 2 examples, information is being obtained in 
different ways

Providing response options in varying degrees will allow you to 
stratify your responses

1. You are a:
___ a. supervisor
___ b. agency head
___ c. administrative assistant
___ d. other employee

2. How many times in the past 12 months did you order supplies?
___ a. Once a week or less
___ b. More than once a week
___ c. Never

Lean Six Sigma
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Define RecapDefine Recap

• How to determine who the customer is: 
SIPOC

• How to set project/process boundaries: 
SIPOC

• How to determine what the customer wants:
CTQs
Customer Interviews

• Do we have everything we need to 
define our project with a narrow scope?

• Do we know how we will measure 
success?
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Problem StatementProblem Statement

• The problem statement should: 
Focus everyone involved on the deficiency at hand
Specify exactly:

…what the problem or issue is
…who owns the problem or issue
…where the problem or issue is
…what the time frame is 

Which?

Lean Six Sigma
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• Quantify the deficiency 
…lost efficiency
…over spending 
...customer dissatisfaction

• Quantify a concrete target
What is your expected improvement target?

• Identify the timing to meet the target
When do you expect to complete your project?

Problem StatementsProblem Statements
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Primary MetricsPrimary Metrics

• How the output/product of the process is measured
• Must be consistent with the Problem Statement
• Must be objectively measured
• Creates the yardstick used to measure the success of the project!

EXAMPLES
• Total Head Count
• Employees Trained
• On Time Delivery
• Customer Satisfaction
• Total Cycle Time

Lean Six Sigma
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Secondary MetricsSecondary Metrics

• The measures that will "keep the process honest“
• They prevent process members/project team from taking a 

problem from one area and moving it to another
Therefore, any associated secondary metrics should be defined 
and tracked to prevent process sub-optimization

EXAMPLES
Primary Metrics Secondary Metrics

• Total Head Count

• Employees Trained
• On Time Delivery

• Customer Satisfaction
• Total Cycle Time

• # of Contractors Used

• # Employees completing 
Program• Number of Extensions

• Reworked Processes
• Total Head Count
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Change IsnChange Isn’’t Easyt Easy

“One of the difficulties in bringing about change in an 
organization is that you must do so through the persons who 
have been most successful in that organization, no matter 
how faulty the system or organization is.

George Washington
Second Inaugural Address

To such a person, you see, it is the best of all possible 
organizations, because look who was selected by it and 
look who succeeded most within it.  Yet these are the 
very people through whom we must bring about 
improvements.”

Lean Six Sigma
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Human FactorsHuman Factors

• Stagnation
May or may not be working hard, but they have no sense of threat-
which indicates a delusional state
Can only end with a forceful demand for change from someone in a
position of power and authority

• Preparation
People feel anxious, jittery, hopeful, threatened, excited, 
betrayed…WIFM
Lack of Leadership alignment – most common cause of failure…NOT 
lack of commitment by middle management

• Implementation
People feel confusion, apathy, resentment, inadequacy, and volatility
It is up to the Leaders to help the employees understand the plan, 
persuade them it will work, motivate them and work with them.

“For a change initiative to succeed, the emotional and behavioral aspects
must be addressed as thoroughly as the operational issues”
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Human FactorsHuman Factors

• Determination
Workers are likely to revert to their old ways, or leave, or worse, 
stay in place but not engage.
Organization starts to experience change fatigue
Retreat

Disguised as apathy, hopelessness, or cynicism
“We need a little breathing space before we begin” “We just need a 
little period of normalcy”.  Because the halt is supposedly temporary, 
the apparent failure doesn’t have to be recognized or addressed.

• Fruition
Confident, optimistic and energized
Stop and acknowledge the people and broadly share the rewards
Distill and assimilate the benefits and lessons learned

“Change can be exhilarating and bring about the best work of a lifetime”

Lean Six Sigma
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Change CurveChange Curve

Stagnation Fruition
Determination

Implementation
Preparation

Organization is Depressed
or Hyperactive Change is abandoned

CRISIS

Awareness that “something
Is wrong”

Vision Strategy &
Plan are shared

Decision to Change
is made

Conflicts, Clashes Failures
& minor successes

Results are 
Realized!

Leaders engage in planning
& communication

Initiative involves multiple
People in multiple layers

“Change unfolds in a reasonably predictable and manageable series of dynamic 
phases, known as the Change Curve”
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The 6 Sigma TeamThe 6 Sigma Team

• Team Leader (You)

• Team Members (Subject Matter Experts [SME] )

• Project Sponsor (Champion)

• MBB 

Four major roles need to be filled for your project to be successful:

Lean Six Sigma
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Definition of a TeamDefinition of a Team

To be a team, you must have…

Common purpose, shared goals
Shared outcomes (risk and rewards)
Specific roles for each member
Interdependency (must collaborate to accomplish 
goals)
Structure and rules
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What Teams Need to be SuccessfulWhat Teams Need to be Successful

• Agreement on and commitment to goals

• Clearly defined roles and accountabilities

• Good processes for getting work done

• Opportunity to learn from mistakes

• Clear understanding of what each team member needs 
from the others

• Commitment to the principles of equality

Lean Six Sigma
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Facilitation SkillsFacilitation Skills

• Manage group conflict

• Create a collaborative environment for participants

• Help generate ideas

• Maintain the focus of group discussion

• Clarify and communicate meeting expectations

• Enable agreement through consensus
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Roles and ResponsibilitiesRoles and Responsibilities

Prepare

• Ensure appropriate team members are included

• Talk to subject matter experts about the purpose of the 
project

• Reserve meeting space

• Prepare any materials

Lean Six Sigma
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Roles and ResponsibilitiesRoles and Responsibilities

Conduct / Facilitate
• Develop ground rules
• Assign roles (i.e. scribe, timekeeper)
• Reiterate / clarify purpose of event
• Ensure group maintains focus
• At the conclusion of the event, review outcomes and 

get agreement
• Record action items
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DACI ChartDACI Chart

D = Driver – The person who is responsible for the action/task.

A = Approver – Process owner:  Responsible for area impacted by project.

C = Contributor – Who should be consulted regarding changes in the process.

I = Informed – The person(s) who is informed after performing the action/task.

Step Action/Task Driver Approver Contributor Informed

1

2

3

4

9

10

11

12

5

6

7

8

13

14

15
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Team Roles and ResponsibilitiesTeam Roles and Responsibilities

Before Project During Project After Project
Team 

Leader
• Review draft Charter with 
Sponsors
• Develop Charter further
• Help Select Team Members

•Manage schedules
•Lead meetings
•Coordinate communication
•Liaison between coach, 
sponsor(s), and stakeholders
•Keep records
•Do team’s work

•Ensure that documents are 
completed and lessons 
captured
•Monitor implementation        
(if appropriate)
•Use improved methods

Team 
Members • Assist with team definition 

and recruiting

•Participate in meetings
•Complete assignments
•Help with team tasks and 
logistics
•Contribute knowledge and 
expertise
•Learn necessary methods 
and acquire needed skills

•Use improved methods



OSD Greenbelt - UNCLASSIFIED 51

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
101 UNCLASSIFIED

•Use improved methods•Approve Tollgates
•Contribute knowledge and 
expertise

•Reviews draft Charter with 
Sponsor

Process 
Owner

•Provide ongoing support for 
implementation
•Ensure monitoring
•Preserve lessons learned

•Provide direction and 
guidance
•Review team progress
•Run interference
•Control budget

•Identify goals
•Select Team Leader and 
Members
•Assign coach
•Approve Draft Charter

Sponsor
(guidance 

team)

•Provide guidance as needed•Provide expert guidance and 
coaching on skills and 
methods
•Help team gather and 
interpret data 
•Help prepare for sponsor 
reviews

• Assist Team Leader
• Help develop Charter 

MBB

After ProjectDuring ProjectBefore Project

Team Roles and ResponsibilitiesTeam Roles and Responsibilities

Project Sponsor may not always be the process owner.  

Lean Six Sigma
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Team Member SelectionTeam Member Selection

• Work with your project Champion 
and/or process Stakeholder(s) to 
determine team composition

What departments will need to be 
represented?
How many ?

• Review your team composition 
with your MBB
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Before the ProjectBefore the Project

• Hold a “Pre-Meeting" to 
verify a common 
understanding and 
agreement on project scope

• Ensure Champion and 
Process Owner (s) 
participate

• Documented agreement in a 
"Project Charter"

Individual space requirementUnit:

Charter

A consistent, transparent, equitable, and future-oriented 
space allocation process

Customer 
Specs:

Space requirement identifiedStart:
Space requirement satisfiedStop:

• Using LSS to standardized space allocation will produce:
– Mission-driven allocation
– Equitable distribution of space
– Reduce missing or conflicting information

• Satisfies DA objective 1.1.2 “Implement new processes for 
allocating and reviewing space requirements to effectively 
manage DIA space challenges”

Business 
Case:

Space requirements for all DIA employees (Gov/Mil/CNTR) 
in the NCR

Scope:

Process variationDefect:

DIA lacks a standardized process to allocate space within 
the NCR

Problem 
Statement:

Individual space requirementUnit:

Charter

A consistent, transparent, equitable, and future-oriented 
space allocation process

Customer 
Specs:

Space requirement identifiedStart:
Space requirement satisfiedStop:

• Using LSS to standardized space allocation will produce:
– Mission-driven allocation
– Equitable distribution of space
– Reduce missing or conflicting information

• Satisfies DA objective 1.1.2 “Implement new processes for 
allocating and reviewing space requirements to effectively 
manage DIA space challenges”

Business 
Case:

Space requirements for all DIA employees (Gov/Mil/CNTR) 
in the NCR

Scope:

Process variationDefect:

DIA lacks a standardized process to allocate space within 
the NCR

Problem 
Statement:
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The Meeting ProcessThe Meeting Process

• Distribute agenda
• Determine objectives
• Plan the process
• Define roles/
responsibilities

• Set time/location

• Start on time
• Set ground rules
• Follow the agenda
• Ensure all contribute
• Assign accountability
• Determine timetables
• Discuss concerns
• Summarize due outs
• End on time

• Debrief
• Publish minutes
• Next steps
• Include benefits &

concerns in next meeting

Plan 
Meeting

Conduct
Meeting Follow Up
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Plan the MeetingPlan the Meeting

• Select appropriate time and location to maximize participation
• Prepare and distribute agenda beforehand
• Create an environment that ensures success
• Agreement on how team members will work and interact with 

one another

Lean Six Sigma
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Conduct the MeetingConduct the Meeting

1. Team leader reviews progress towards goals

2. Team identifies, analyzes, and solves problems

3. Team records action items

Including who is responsible and when the task should be complete

4. Team provides input for the next meeting’s agenda

5. Meeting minutes are recorded All ideas are valuable
Generate first
Evaluate second
“Build” on others ideas

Be open
One person at a time

TI
PS



OSD Greenbelt - UNCLASSIFIED 54

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
107 UNCLASSIFIED

Guidelines for Achieving ConsensusGuidelines for Achieving Consensus

• Involve everyone in the discussion
• Explore alternative choices
• Listen to others
• Identify actual problems, not symptoms
• Be wary of quick solutions
• Encourage differences to help clarify issues 
• Do not compete
• Allocate time carefully
• Strive for the best answer
• Avoid conflict reducing techniques (e.g., majority vote, averaging, coin flip, etc.)
• Yield only to positions that have objective and sound foundations

Consensus helps a decision survive!

Lean Six Sigma
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Meeting FollowMeeting Follow--upup

• Discuss roadblocks and barriers

• Distribute the meeting minutes as soon as possible after the 
meeting to:

Managers
Supervisors
Other interested parties
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Team building
Intros
Ice Breakers
Ground rules

Attendance
Promptness
Participation
Chores
Breaks
Work assignments

Expected level of commitment

First MeetingsFirst Meetings

Lean Six Sigma
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ADJOURNING

Stages of Team GrowthStages of Team Growth

NORMING

3

STORMING

2

FORMING

1

PERFORMING

4
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Verbal CommunicationVerbal Communication

Verbal communication is frequently abused in meetings and 
team environments.

• What are some examples of negative verbal communication?

• What effect can negative verbal communication have on a 
team?

• What are some examples of positive verbal communication?

Lean Six Sigma
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NonNon--Verbal CommunicationVerbal Communication

It’s important to observe your body language (non-verbal communication) for 
the impact it has on the team.
The team members will tend to read your body language, interpret it, and 
react to it.

Positive cues
• Eye contact (positive interest)
• Smiling (encouragement)
• Leaning forward (positive interest)
• Nodding yes (Agreement)

• Evasive glances (discomfort)
• Slouching (disinterest)
• Shaking head no (disagreement)

Negative cues
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Overcoming Roadblocks Overcoming Roadblocks -- InfluenceInfluence

Influence

Use of personal energy to change an outcome or make 
an impact on a situation

• I can’t get the data I need!

• My team is stalled!

• The process owner wants to steer us in another 
direction!

• Nobody will make a decision!

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
114 UNCLASSIFIED

Position vs. InterestPosition vs. Interest

Position…

We don’t have the $$$
to make that change

… vs. Interest

I’m afraid to make the 
change – something 
might go wrong

I can’t get the data 
you’re requesting

If someone starts 
investigating my process, I 
could lose billets
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ID and Address the InterestID and Address the Interest

First try to discover the interest

Might be different from position

Second, use your influence to deal with the interest

Influence styles Social Power
Involvement Reward – you can provide something
Negotiation Coercive – you can punish
Persuasion Legitimate – you have authority
Appealing Expert – you’re the acknowledged SME
Dictating Informational – you have desired info

Reverent – charisma, natural leadership

Lean Six Sigma
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Case Study 1Case Study 1

It’s the first day of your project and one of 
your key team members, Sally, has hardly 
spoken a word.  She sits silently, with her 
arms crossed and won’t make eye contact.  
You are depending on her expertise and 
need her ideas.  

As the facilitator, what can you do to 
encourage her participation?
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Case Study 2Case Study 2

Team member, Ben, has been a valuable 
asset.  He’s always the first to volunteer 
and speaks up at every opportunity, but 
doesn’t listen to others’ ideas.  He 
sometimes speaks forcefully in an attempt 
to exert control and even takes the lead on 
group activities without being asked. 

How can you ensure a good team process 
and team member involvement?

Lean Six Sigma
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Case Study 3Case Study 3

Things were going smoothly until the team 
began the process map of the current state.  
Now they’re jumping to solutions and the 
group is disintegrating into smaller sub-
teams with no focus for the work.

What needs to be done to get the team back 
on track?  
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Case Study 4Case Study 4

It’s day three and tension is high.  Lou and 
Robin are not listening to each other.  Both 
are frustrated and the unproductive debates 
have led to sarcasm and personal attacks.  
The other team members are hopeful that 
you, the Green Belt, can help the group 
come to a consensus and implement a 
strategy.

How can you get this team to commit and 
take ownership?

Lean Six Sigma
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Define Phase Review QuestionsDefine Phase Review Questions

• Have you defined the problem to be addressed by the project?

• Who is the customer (internal or external)?

• What is the expected process impact?

• When do you expect to complete the project?

• Does this project have applications in other areas?  

??
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• Have you completed the Problem Statement?
• Have you selected a project team?
• Is your Project Charter complete?
• Have you consulted with your Master Black Belt?
• Use Tollgate to determine next steps

Based on your answers…
what do you think your next steps 
will be for completing the Define 
Phase of the DMAIC process?

??

Define Phase Review QuestionsDefine Phase Review Questions
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Define

Measure

Analyze

Improve

Control

Measure
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• Critical to validity of conclusions 
• Generally not readily available or accessible
• Often not in a user-friendly format
• Forms the foundation for your project!

Data Collection
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• Throughput
• Customer
• Time of Day
• Employee
• Location
• Size
• Cycle Time
• Schedule Attainment
• Waste or Spoilage
• Cost
• Number of employees
• Proportion defective
• Number of errors

Things We MeasureThings We Measure

Lean Six Sigma
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Quantitative Qualitative

Non-Numeric by nature
Expressed as a CATEGORY

• Pass/Fail
• Type of Department
• Name of Branch

Numeric in nature
Expressed as

AMOUNT of something

• Time
• Distance
• Money

Types of DataTypes of Data
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Discrete
There are no 

intermediate values 
between successive 

values

Clearances 
P / F

Deployments 
on time / late

Late 
warnings 
Issued

# of Late 
Awards

Reports 
Errors   Y / N

Continuous
There are 

intermediate values 
between any two 

values

% of 
Reports 

Reworked

Report 
Cycle 
Time

Processing 
Days

Obligation 
Rate

Overtime 
Hrs per 
Week

Examples of Types of MeasurementExamples of Types of Measurement
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Continuous Discrete

$ $

more refined
information

more coarse
information

Continuous vs. DiscreteContinuous vs. Discrete

• Depends on the problem!

• Often you will not have a 
choice.  Your process 
dictates the type of measure 
you will have

• If a continuous metric is 
feasible… it is preferred

Which is a better metric…
continuous or discrete?



OSD Greenbelt - UNCLASSIFIED 66

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
131 UNCLASSIFIED

Types of MeasurementsTypes of Measurements

Data Type

Lateness of Delivery

Defective Weapons Parts

Overdue Shipments

Pounds of MREs Shipped

Tons of Body Armor

Equipment Breakdowns

Production Cycle Time

Lost Customers

Errors on Reports

Changes to Plan

% Rework

Continuous

Discrete

Discrete

Continuous

Continuous

Discrete

Continuous

Discrete

Discrete

Discrete

Continuous
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Pop QuizPop Quiz

• List the categories below by the measure type :

Measure Type
Data Characteristic

Continuous Discrete

1 Student's grade in a class

2 Time to Get to Work

3 Today's Temperature

4 Automobile Type

5 Gender

6 Age

7 Cycle Time

8 Pass Fail

9 # of People on a Bus

10 Quality Inspection
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A B

Package arrives at Step A at 8 am. Package arrives at Step B at 9 am.

Cycle Time = 1 hour

Cycle TimeCycle Time

• The actual time needed to complete a step and move on to the 
next step in the process

Caution: Operationally define start and stop times BEFORE collecting data!
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Defectives & Defects Defectives & Defects 

• A defective unit is that which fails to 
meet customer requirements or 
standards

Late order, incorrect invoice, short-count, 
etc. 

• A defect is any reason for such a 
failure

Not filed correctly, incorrect line item, 
transposed numbers, etc.

• A defective unit can have more than 
one defect
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Defects Per Unit (DPU)Defects Per Unit (DPU)

• Defects Per Unit (DPU) – the average number of defects, 
of all types, over the total number of units produced

Unit is the item being processed 
(order, invoice, form, plate, etc.)

DPU =
Total Number

Units Processed

Total Number Defects
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DPU ExampleDPU Example

• In one month, 220 reports were 
sampled after being sent to 
customers
• Among the 220 reports, 344 line 
items were found incorrect 
(defects)

Unit =   Report
DPU =   344 incorrect line items 

/ 220 Reports
= 1.56
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How Many Samples do I Need?How Many Samples do I Need?

• Depends on 4 factors:
The type of data (discrete or continuous)
The objective of the sampling process

Describe a characteristic for a whole group (mean or proportion), within a 
certain confidence interval ( +- ___units)
Compare a group of characteristics ( find difference between group means 
or proportions; at what power – the probability of detecting a certain 
difference)

What estimate of σ will be
How confident you want to be when you state your conclusion about the 
overall performance

There is typically a 
trade-off between: Cost

Sample Size

Accuracy

Lean Six Sigma
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SamplingSampling

• Sampling 
That part of statistical practice concerned with the selection of individual 
observations 
Intended to yield knowledge about a population for the purpose of 
statistical inference

• The sampling process consists of :
Definition of population of concern 
Specification of a sample frame

…a set of items or events that can be measured
Specification of sampling method for selecting items or events from the 
frame 
Determine the sample size 
Implement the sampling plan 
Sampling and data collecting 
Review of sampling process 
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Sample PlansSample Plans

• The purpose of a sample:
To gain the ability to draw statistical conclusions about the population of 
data

• A Sample Plan:
The process by which the Sample will be obtained

• Determining the correct MINIMUM sample size is a very 
important issue.

Samples that are too large may waste time, resources, and money
Samples that are too small may lead to inaccurate results 

It is not always possible or feasible to gather and 
analyze 100% of the data from a process

Lean Six Sigma
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Population vs. SamplePopulation vs. Sample

Population
• An entire group of objects containing 

a characteristic of interest
• Highly unlikely we can ever know the 

true population parameters
The average days to bill all 
customers 
All registered voters in the U.S.

Sample
• A sample is usually a subset of 

the population of interest
• The group of objects actually 

measured in a statistical study
The average days to bill 
customers this year
A survey of 1,000 voters

“Population Parameters” (Greek Symbol)
μμ = Population mean
σσ = Population standard deviation

“Sample Statistics” (Roman Symbol)
XX = Sample mean
ss = Sample standard deviation

Sample

Po
pu

la
tio

n
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X XXX
X

X

X

X
X

X
X

X

X
X

X

X X

X

X
X

X X

XX
X

Population Sample

SamplingSampling

• Collecting only enough individual data points from a process to 
determine the sources of variation

• A fast, low cost way to describe a process
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When Sampling WorksWhen Sampling Works

Random… Each unit/transaction has an equal likelihood of being 
selected 

Independent… Selecting one unit/transaction does not influence the 
likelihood of another unit/transaction being selected 

No Bias… There are no significant differences between those selected 
and those that are not

Frequency… Your sample is large enough to see what you are looking for
NOTE: If what you are looking for is rare or you want to be 
very precise, you will need a very LARGE sample



OSD Greenbelt - UNCLASSIFIED 72

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
143 UNCLASSIFIED

Sampling PlansSampling Plans

• A Sampling Plan is a method of inspecting a prescribed portion of the 
production run.  

• Quality cannot be inspected into a product; it must be produced that 
way.

• The Sample Inspection Process is used for:
Obtaining an estimate of how good, or bad, the rest of the run might be.
Ensuring that production quality guidelines and specifications are followed.
Determining inspection criteria whether a product should be shipped or not.
Determining incoming material inspection criteria for accepting or rejecting 
shipments
Providing an estimate of performance 

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
144 UNCLASSIFIED

Sampling PlansSampling Plans

• For conclusions to be valid, samples must:
Be representative of the whole

Consider what groups to sample, and the proportion of each group

Consider when to sample

Consider where to sample

• Sampling Approaches
Random Sampling – Each unit has the same chance of being selected

Stratified Random Sampling – Randomly sample a proportionate number 
from each group

Systematic Sampling – Sample every n    one, (i.e every 3rd)

Subgroup Sampling – Sample n units every n    time (i.e. 3 units every hr) 
Then calculate the mean of each subgroup

th

th
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Examples of Sampling PlansExamples of Sampling Plans

xx
x

x

xx

xx
x

x

x

x x

x

x

x

x

x

x

x

x

x x

x x x

Population
Sample

xxx
x
x

xx
x

x
x

x
x xx

x

x x

xxx
x

xxx

x

x
x
xx x

x x xx

x
x x

xx xxx
xxxx

Population

Sample

x x x x xx x x xxx x

Population

x
xx

x
x

x
x

x x
x x

xx
x

x
xx

x
x

x
x

x x
x x

xx
x

6:00 7:00 8:00 9:00

xx x x x

Random Sampling

Stratified Random
Sampling

Systematic Sampling

Subgroup Sampling

Preserve Time Order!

Preserve Time Order!

Sample
Sample Population
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Mitigating the Risk of SamplingMitigating the Risk of Sampling

• Risk of making a wrong decision
Decrease risk, Increase Sample

• Variation in measurements
Larger variation, Increase Sample

• Difference to be detected
Difference decreases, Increase Sample

• Consider cost, practicality, representation
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Normal DistributionsNormal Distributions

• Normal Distributions are a family of distributions
They are symmetric, with data points concentrated more in the 
center than in the tails.

• Normal Distributions are defined by two parameters
Mean
Standard Deviation

Which is a Normal Distribution?

1 2
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Empirical Rule for Normally Distributed DataEmpirical Rule for Normally Distributed Data

Central Limit Theorem

The means of samples from a population will tend to be normally distributed 
around the population mean
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Approximately 68% of the observations

fall within 1 standard deviation of the mean

Empirical Rule for Normally Distributed DataEmpirical Rule for Normally Distributed Data

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
150 UNCLASSIFIED

Approximately 95% of the observations

fall within 2 standard deviations of the mean

Empirical Rule for Normally Distributed DataEmpirical Rule for Normally Distributed Data
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Approximately 99.7% of the observations

fall within 3 standard deviations of the mean

* Only a small fraction of 
observations (1 out of 333 or 0.3%) 
lie outside this range

Empirical Rule for Normally Distributed DataEmpirical Rule for Normally Distributed Data
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• Another way of looking at it
• This is merely a consequence of 

the 68-95-99.7 rule

Empirical Rule for Normally Distributed DataEmpirical Rule for Normally Distributed Data
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Issues of NonIssues of Non--NormalityNormality

• Non-normal data

• Tests for normality
Minitab, graphical/visual

• Impact: statistical tests may 
provide less valid results

May be improved by 
collecting more data

Must consider costs of 
data collection

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
154 UNCLASSIFIED

Describing VariationDescribing Variation

99
95
92
88
83
76
65
55
55
54
53
41
40
39
33

Test 
Scores Mean or Average

Tells you where the center point of the process is located

Median
Tells you where the center point of the data is located

Range
The distance between the highest and the lowest points 
(Indicates spread)

Standard Deviation
A more descriptive measure of spread
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MeanMean

• Indicates location of process
• Reflects all the data values
• Influenced by extreme values
• Also known as “Average”

968
15

=  64.5

99
95
92
88
83
76
65
55
55
54
53
41
40
39
33

=968

+
+
+
+
+
+
+
+
+
+
+
+
+
+

Test 
Score

s Mean =
Number of 
data points

Sum of all data points
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• The center number after the data has been sorted in 
ascending order

If even number of data points, the Median is the average
of the two middle data points

• The 50% rank of the data
• Indicates the location of the data
• Does not use all values in the calculation
• “Robust” to extreme values

Median

99
95
92
88
83
76
65
55
55
54
53
41
40
39
33

Test 
Scores

MedianMedian



OSD Greenbelt - UNCLASSIFIED 79

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
157 UNCLASSIFIED

RangeRange

• The distance between the extreme 
values in the data

• Only uses two data points

99 – 33   = 66

99
95
92
88
83
76
65
55
55
54
53
41
40
39
33

Test 
Scores

Lowest Value

Highest ValueRange =
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Standard DeviationStandard Deviation

• A more descriptive measure of spread than range
• Takes into account the difference of each data 

point from the mean
• Uses all the data
• Smaller is better

( )

1
   

2

1

−

−
=≈

∑
=

n

xx
s

n

i
i

σ

Mean 1σ
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2)X-(X    X-X      X

Standard Deviation CalculationStandard Deviation Calculation
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Exercise: CatapultExercise: Catapult

• Each person in team fires the 
catapult 5 times

• Measure performance by:
total length of flight
Distance of landing from center line

• Record the data:
Using handout
Bombardier (Name)
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Sigma

Median

Mean/Average

Total

Distance from Center 5

Distance 5

Distance from Center 4

Distance 4

Distance from Center 3

Distance 3

Distance from Center 2

Distance 2

Distance  from Center 1

Distance 1

Test Firing

NameGroup #

Exercise: CatapultExercise: Catapult
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• What did you learn from firing the catapult?

• Can you draw any conclusions?
Are your conclusions proven or speculation?

• What would you suggest as the next step in the process?

Exercise: CatapultExercise: Catapult
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DataData

• Think about your project:
Do you know if data already exists?  
If it does, what do you know about it? 
Is it any good? 
Can you trust it? 
How was it collected?
Is there an SOP for collecting the data?
What is the training level of the persons collecting the data?
If equipment is used, what is the integrity of the collection 
process?

Lean Six Sigma
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Data IntegrityData Integrity

Thorough data collection and validation can be tedious, 
but the consequences of not doing it right 

are invalid conclusions, wasted time, wasted money, and 
inefficient use of resources.
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Total VariationTotal Variation

Total 
Variation

Due to the way the 
process works

Due to the way we 
measure our process

Total Variation = Process Variation + Measurement VariationTotal Variation = Process Variation + Measurement Variation

Lean Six Sigma
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Process
Variation

Measurement
Error

Total
Process Variation

p MTotal

Total VariationTotal Variation

σ   total  = σ + σ     Mp
2 2 2
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• If a significant portion of the variation in your process is a 
result of the data collection process, what might your first step 
be?

σ   total  = σ + σ     Mp
2 2 2

Total VariationTotal Variation

Process
Variation

Measurement
Error

Total
Process Variation

Lean Six Sigma
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• Data Unavailable, Gaps in Collection
• Recording/Judgement Errors
• Keying Errors
• Legibility Errors
• Undefined and/or Poor Instruction
• Poorly Designed Forms

Reasons for Measurement VariationReasons for Measurement Variation
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• Measurement System Analysis, aka “MSA”
• MiniTab refers to MSA as a Gage R&R
• Gage R&R studies are used to:

Determine the capability of the measurement system across the 
range of process output

Assess repeatability, or whether the same operator (or 
measurement system) can achieve the same measure multiple 
times

Assess reproducibility… or whether two different operators (or 
measurement systems) get the same answer when measuring 
the same sample

Measurement System AnalysisMeasurement System Analysis
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• Components
Discrimination
Accuracy
Repeatability
Bias Effects
Stability

• Components 
Uniformity
Effectiveness
Bias
Miss
False Alarm

Gage R&R (MSA)Gage R&R (MSA)

Continuous Data Discrete Data
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• Discrimination: The technological ability of the 
measurement system to adequately differentiate 
between values of a measured parameter

.28

.282

.2819

ruler
caliper
micrometer

1.0 pounds
1.09 pounds

1.1 pounds

Gage R&R: Continuous DataGage R&R: Continuous Data

• A poor performing Gage may give you different 
readings each time you measure the same object

Lean Six Sigma
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Average Value

Master or Reference Value

• Accuracy: The difference between the observed average value 
of the measurements and the master value

Gage R&R: Continuous DataGage R&R: Continuous Data
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RepeatabilityRepeatability

• Repeatability: the variation between successive measurements of 
the same part preformed:

with the same gauge
by the same person
doing it the same way (an estimation of short term variation)

Lean Six Sigma
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StabilityStability

• Stability: (or drift) is the total variation in the measurement system on 
the same part when measuring the same characteristic over an 
extended period of time

1 2 3 4 5 6 7 8 9

Time
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• Reproducibility: The difference in the average of the 
measurements made by different people using the same or 
different gauge but measuring the same characteristic 

Gage R&R: Continuous DataGage R&R: Continuous Data
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• Reproducibility
• The average measurements are 

different by fixed amounts from the 
reference value

• Bias effects include
Operator bias (operators look at the 
same image and draw a different 
conclusion)
Machine bias (detection sensitivity 
may be set differently for detection 
of the same trigger )

Gage R&R: Continuous DataGage R&R: Continuous Data
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LinearityLinearity

• Linearity: the consistent ratio of output (measurement) to input 
(measured quantity) through the expected operating range of the gauge

2015105

25

20

15
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0

Index

C
1
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• Uniformity refers to the overall agreement within and 
among operators. This is similar to the repeatability (within 
operator) and reproducibility (between operators) aspects 
of a variable measurement gage

• Effectiveness (E) is the operators ability to detect good 
and bad units

• Miss occurs when a bad unit is accepted as good

• False Alarm means a good unit is rejected

Gage R&R: Discrete DataGage R&R: Discrete Data
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What do you know about the Measurement Process?What do you know about the Measurement Process?

• Written inspection/measurement procedure?

• Do the measurement points show up on the process map?

• What is the training level of the operators?

• Do our measurements correlate to other known sources?

• Are there measurement specifications?

• Is there a gauge?

• Does the gauge being used meet the needs of the process?

Lean Six Sigma
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• Think about your project:
Do you know what your process looks like? 
Do you know if data already exists?
If it does, where is it being collected?
If there is no data, where should you collect it?
How do you determine the correct location(s) for data 
collection/process measures? 

ProcessProcess
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Process Map or FlowchartProcess Map or Flowchart

• A Pictorial Representation of a Process
Identifies Inputs (X) and Outputs (Y)
Identifies Current Data Collection Points
Categorizes Inputs (X)

• Defines Process Boundaries
Identifies customers and suppliers

• Points out discrepancies in the process

• Points out inefficiencies in the process
Determines Value-Added and Non-Value-Added Steps

• Initiates standardization of procedures

Lean Six Sigma
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• Symbols to know:

• Determine the start and finish of the process you are charting
• Define how the process actually works, step by step, in detail
• Use observation, recorders, etc.
• Add inputs and outputs

Process Map ProcedureProcess Map Procedure

Process
StepStart/End Decision Flow
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• 50,000 foot view of the process
• Identifies customers and suppliers
• Identifies products and / or services of the process
• Identifies Key Measures

HighHigh--Level Process MapLevel Process Map

Lean Six Sigma
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PPSS II OO CC

SIPOC SIPOC 

Suppliers Inputs Process Outputs Customers

Process
Map

SIPOC: The starting point for any process map
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Example Example HighHigh--LevelLevel Process MapProcess Map

• Shipping Instructions
• Complete Order
• Truck

• Bill Of Lading
• Product Distribution 

Instructions
• Complete Order 

Shipped to Customer

•Customer Service
•Production
•Carrier

•External Customer
•Billing
•Customer Service

Shipping

Lean Six Sigma
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Who is the Customer?Who is the Customer?

Internal
CustomerProcess External

Customer

DOD Y = f(x)Y = f(x)Y = f(x)

• Customers are recipients of products and/or services
Internal Customers use our outputs for their processes.
External Customers pay our bills 
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Internal
Supplier

External
Supplier Process

Who is the Supplier?Who is the Supplier?

• Suppliers provide products and/or services
Outputs of “internal suppliers” are inputs to our process
We pay “external suppliers”

Y = f(x)Y = f(x)Y = f(x)DOD

Lean Six Sigma
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Simple Process MapSimple Process Map

Start Step 1

No

Yes
Step 2

End

Decision

• Describes the high-level steps followed day in and day out
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Process MapProcess Map

• Process mapping is a technique to make work visible
A pictorial representation of a process

• A process map shows: 
The sequence of events 
Where decisions are made 
Who is doing what

with whom
when

» for how long

Wait times or delays inherent to the process

Lean Six Sigma
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Process MapProcess Map

• Identify opportunities to 
Reduce cycle time
Avoid rework
Eliminate inspection steps
Prevent errors

• There probably has never been a process map 
developed where someone has not said:

"Do we still do that?" 
"Why does X happen there?" 
"Why do we do it that way?“
"I did not realize...." 
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How to Analyze a Process MapHow to Analyze a Process Map

• Look at each process step for:
Errors being fixed instead of prevented (rework) 
Role ambiguity (we didn't know who...) Bottlenecks 
Sources of delay 
Duplications 
Unnecessary steps 
Cycle time

• Look at each decision point for:
Sequence (are the decisions needed at this point?)
Authority ambiguity (two or more people get to decide...) 
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How to Analyze a Process MapHow to Analyze a Process Map

• Look at each rework loop to:
Eliminate steps
Reduce time
Prevent rework

• Use the customer's point  of view to  determine:
Value-added 
Non-value-added steps

• Confirm Process Boundaries between:
Customers 
Suppliers

• Look for discrepancies in the process

• Determine if procedures are standardized
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Process Map: ExampleProcess Map: Example

Shower
& Dress Eat

Park

Get Up

Walk In

Which
Vehicle

Which
Route

Car Truck

Route A Route B
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There are usually 3 versions of each Process Map

What you Believe it is... What it Actually is... What you Want it to be...

Always Keep in MindAlways Keep in Mind……
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Customer
Create Specs

Sales pre 
engineering &

Forward Specs 
to CS

Customer Service
Received

Proposed Specs

Evaluate for
Compliance with

Division
Capabilities

Can Job be
run as is?

New or 
Revised?

Enter into JI
for Schedule

Production
Control assign

Schedule

Revise JI, Notify
Prod Control

Prod Control
Review Changes
Revise Schedule

Notify Sales
and Customer
of Schedule

Notification
sent to Sales

Manufacturing

Create Job 
Tickets & Send 

to Mfg.

Revised

New

No

Yes

Process Map ExampleProcess Map Example
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• Xs are the inputs that impact the ability to achieve the Ys of that 
process step

• Ys are the results of completing the process step 
• A “Y” from one process can be an “X” for a later process
• Note: The DPUs of each process step are the DPUs introduced by the materials 

added or the processes performed at that step

Elements of Process ImprovementElements of Process Improvement

OROR

Goal: Y = f (XGoal: Y = f (X11, , …… , X, XNN))

Inputs Outputs

X1 

X2

X3
...

Y1 

Y2

Y3
...

Process Step

* DPU
Cycle Time

Inputs
(Xs)

Outputs
(Ys)Process Step

* DPU
Cycle Time
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Creating a Useful Process MapCreating a Useful Process Map

Step 1: At an actionable level, define the boundaries of the process you
need to improve

Step 2: Identify all operations needed in the production of a product or
service. At each step include:

Cycle time
Quality levels

Step 3: Identify each operation above as value-added or non-value-
added. A value-added operation “transforms the product in a way 
meaningful to the customer”

Step 4: List both internal and external Ys at each process step

(continued)
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Creating a Useful Process MapCreating a Useful Process Map

Step 5: List both internal and external Xs at each process step

Step 6: Classify all Xs as one or more of the following:
Controllable (C): Inputs you can adjust or control while the process is 
running

Examples: Speed, feed rate, temperature, pressure

Standard Operating Procedures (SOPs): Common sense things you always 
do because they make sense

Just because it is in a procedure --does not mean it is an SOP 
Procedures can be used to specify set-points of controllable 
parameters
Examples: Cleaning, safety, loading components, setup

Noise (N): Things you cannot control or do not want to control (too expensive 
or too difficult)

Examples: Ambient temperature, humidity, operator (continued)



OSD Greenbelt - UNCLASSIFIED 100

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
199 UNCLASSIFIED

Creating a Useful Process MapCreating a Useful Process Map

Step 7: Document any known operating specification for each input and 
output

What are the operational requirements of the process?

Examples: Obligation Rate 8% per month

EOD (End of Day)  +/- 1 day

Recon Imagery Resolution +/- 1 meter

Step 8: Clearly identify all process data collection points
What are the DPUs of the various process steps?

What is the Rolled Throughput Yield (RTY) of the Process?

Lean Six Sigma
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Non-Value-Added activity reduces speedNon-Value-Added activity reduces speed

Air Travel from NYC to Chicago

Arrive Airport 1 hr before departure = 60 minutes
Taxi from gate to runway = 10 minutes
Flight to from NY to Chicago = 121 minutes
Taxi from runway to gate = 10 minutes
Wait at baggage carousel = 15 minutes
Elapsed Time = 216 minutes

Value-Added = 121/216  =  56%

Example:  ValueExample:  Value--Added AnalysisAdded Analysis
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ValueValue--Added AnalysisAdded Analysis

• Value-Added Steps
Customers are willing to pay for it
It physically changes the product
It’s done right the first time

• Non-Value-Added Steps
Not essential to produce output
Does not add value to the output
Includes:

Defects, errors, omissions
Preparation/setup, control/inspection
Overproduction, processing, inventory
Transporting, motion, waiting, delays

all ceiling 
lights are 
replaced but the

 

wiring is

still ba
d
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Process Map: Red Flags Process Map: Red Flags (1 of 4)(1 of 4)

• Assumptions
Challenge all assumptions
It's easy to forget that a process step was based on 
assumptions and not fact

• Changes
Changes made to be creative or for some other reason that 
are NOT linked to the business plan or a business need

• Flexibility
Can the process respond to changes in 
customer/technology requirements?

• Duplication
Duplicate data entry 
Duplication of efforts/steps in another group
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• Forgot how or too complex
Mistakes due to a complex procedure or because people 
forgot what to do
Consider job aids: list, check-sheet, flowchart, picture

• Intermediaries
Question "coordinate," "pass it by me first," "expedite“, and 
"liaison" for value-added

• Lack of consequences
No consequence or negative feedback for not following 
standards

Process Map: Red Flags Process Map: Red Flags (2 of 4)(2 of 4)
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Process Map: Red Flags Process Map: Red Flags (3 of 4)(3 of 4)

• Quality control
Prevention instead of detection is the desired process
Can the work be mistake-proofed to make it impossible for 
the defect to be passed on?
QC of work when the "supplier" could have delivered 100% 
QC input
Is the QC check really needed? What is the defect rate?

• Resistance
Someone saying this won't work… we tried that already… we 
can't make any changes

Be neutral. Remind all involved that process improvement
is why we are here!!

Do they claim there is no standard because they did not 
agree to it?

• Repetition
Can repetitive work be automated?
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Process Map: Red Flags Process Map: Red Flags (4 of 4)(4 of 4)

• Scalability
Is the process limited to the current workload? 
Is it scalable to handle a larger volume of work?

• Specifications
Treat every time like the first

Developing specifications each time something is done 
instead of only the first time as a standard or template

• Supplier Input
Input supplier sends inaccurate/incorrect input

Ask if they know what to do

• Old ways
People have not or won’t get trained on new tools/software
Old ways in new tools… lots of steps in software that just 
replicate the old manual process

Lean Six Sigma
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Value Analysis MatrixValue Analysis Matrix

• Helps clarify not only what types of waste are present in the 
process, but also the percentage of the overall process each 
non-Value-Added step adds
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• In your group, create a process map for firing 
the catapult

• Make sure that you clearly define your 
Inputs
Outputs
Data collection points
Equipment / suppliers

• The process for building it must be written down

• Test your process following your Process Map 
steps 

Example : CatapultExample : Catapult

Lean Six Sigma
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Data Collection PlanningData Collection Planning

• Gather the data that addresses the Problem Statement 
and Business Case

• Determine what you want to measure
• Write clear operational definitions for all measures
• Develop a Collection Plan
• Collect and record the data using Excel columns
• Audit the data to be sure that it is valid and reliable



OSD Greenbelt - UNCLASSIFIED 105

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
209 UNCLASSIFIED

Jim Jackie Tom Total

Key errors 20 24 16 60

Spelling Errors 11 23 9 43

Late Completion 75 26 34 135

Wrong Sequence 12 2 6 20

Layout 4 0 5 9

Late Delivery 7 14 9 30

Unknown 5 2 19 26

135 93 101 323

Check SheetCheck Sheet

• Check Sheets can also be used to cross reference events with time 
or other dimensions or see emerging patterns 

Resist the natural 
urge to focus on 

the individual 
performance.  
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Jim Jackie Tom Total

Key errors 20 24 16 60

Spelling Errors 11 23 9 43

Late Completion 75 26 34 135

Wrong Sequence 12 2 6 20

Layout 4 0 5 9

Late Delivery 7 14 9 30

Unknown 5 2 19 26

135 93 101 323

Improving the 
process, will 

improve the overall 
performance for 

everyone.

Check SheetCheck Sheet

• Check Sheets can also be used to cross reference events with time 
or other dimensions or see emerging patterns 
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Jim Jackie Tom Total

Key errors 20 24 16 60

Spelling Errors 11 23 9 43

Late Completion 17 13 19 49

Wrong Sequence 12 2 6 20

Layout 4 0 5 9

Late Delivery 7 14 9 30

Unknown 5 2 19 26

59 78 83 276

Check SheetCheck Sheet

• Improvement of the process, improved overall performance

How many 
people wanted 

to fire Jim?
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Data Collection ProcedureData Collection Procedure

• Make a list of categories to measure or draw a map of the 
process components

• Decide who will gather data and how

• Design an Excel spreadsheet to record the data

• Review and act on the information!

• Did the data represent the problem?

• Adjust collection plan and continue to collect as needed
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Measure Phase Review QuestionsMeasure Phase Review Questions

• What is the purpose of the Measure Phase?

• What are the Ys or outputs?
How did you determine them?
How are you measuring them?

• What are the Xs or inputs?
How did you determine them?
How are you measuring them?

• Is data already being collected?
If yes, does the data pass a Gage R&R? 
Is the data being collected in the areas of interest?

• If no data exists, do you know where you want to collect data?

Lean Six Sigma
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• What Xs have been identified as potentially having an impact?
Have you assessed the impact of these Xs with data?
If not, what is your plan to do so? 

What tools do you think you will be effective for the type of data you 
have?

• Is the problem you face concerned with moving the mean or 
shrinking the variance, or both?

• Do you have adequate resources to complete the project?
Are there any issues or barriers?

Measure Phase Review QuestionsMeasure Phase Review Questions
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Analyze
Define

Measure

Analyze

Improve

Control

Lean Six Sigma
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Searching for XsSearching for Xs

• The primary focus of the analyze phase is to separate the 
Critical Few from the Trivial Many

• In short: What is driving our deficiency or variation?

All Possible Xs Probable Xs
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Prioritize ProblemsPrioritize Problems

• Prioritization will:
Provide a priority list of the sources of variation 
Guide team activities
Guide the tracking of those activities 
Give a starting point of questions to ask and answers to find first

• The Failure Modes and Effects Analysis (FMEA) tool helps us 
prioritize

Lean Six Sigma
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BrainstormingBrainstorming

• Display the question the group is considering
• Ask the group to answer the question with silent writing
• Collect the ideas from each group member, one at a time

No criticism or discussion
Do not interrupt others
Any individual may pass on any turn

• Record the ideas as stated for all to see
• When everyone passes on the same turn, discuss the ideas

Clarify
Combine similar ideas
Identify common themes or categories
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Brainstorming GuidelinesBrainstorming Guidelines

• Don’t critique ideas
• Use freewheeling imagination
• Build on other’s ideas
• Aim for quantity
• Record each idea as stated

Lean Six Sigma
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Brainstorming ExampleBrainstorming Example

• Data errors in application
• Application not submitted
• Incomplete information
• Missed deadline
• Forms lost in mail
• Paperwork misfiled
• E-mail latency
• Faxed to wrong number
• Data entry error
• Incorrect exchange rate

Entitlements Problems: late / incorrect pay
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5 Whys5 Whys

• Technique to get from symptom to root cause

• Asking “Why?” as many as five times to get to root cause

• By identifying root cause we can take action to prevent recurrence

Lean Six Sigma
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5 Whys: Computer Failures5 Whys: Computer Failures

Computer
Program
Failure

Installed
Incorrectly

Accessed 
Incorrectly

Bug in 
Software

Did Not
Follow

Directions

Did Not
Read

Directions

No
Directions

Handling
Damage

Written 
with
Bug

Not Written
Clearly Not

Written
Not

Packaged

Packaging
Error

Unskilled
Programmer

Typo

WHY?

WHY?
WHY?

WHY?
WHY?WHY?

WHY?

WHY?
No Format

No One
Assigned 

to
Develop

WHY?

WHY?



OSD Greenbelt - UNCLASSIFIED 113

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
225 UNCLASSIFIED

MultiMulti--votingvoting

• Narrows the number of choices 

• Based on individual opinion, experience

• Must be followed up with data (Analyze tools)

Lean Six Sigma
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MultiMulti--votingvoting

• Give each team member 10 points and let them distribute 
across the options, OR

• Give each team member 3 multi-colored dots (red, blue, 
green) to represent high, medium, and low to distribute 
across the options

• Focus next steps on the item(s) with the highest number of 
votes and / or score

• Obtain data to validate
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Fishbone DiagramFishbone Diagram

Output

Policies Materials

People Procedures

Measure

• Used to categorize problems and/or possible solutions
• Very useful for finding the root cause (s) of a problem 
• Also known as Cause-and-Effect Diagram
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Fishbone Diagram ProcedureFishbone Diagram Procedure

• Write the problem (effect or “Y”) in a box on the right side with an 
arrow entering from the left

• Generate a list of causes that potentially create the problem

• Organize the causes into categories

Place causes on the fishbone by category

• Breakdown the causes into smaller components by asking “Why?”

Add to fishbone

• Examine for patterns, root causes, data needs
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WhatWhat’’s the s the BiggestBiggest Source?Source?

Policies Materials

People Procedures

Measure

Not using standard operating procedures 
is often the single largest source of variation!

Output

Lean Six Sigma
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Fishbone ExampleFishbone Example

Supervisor
check

Written transcription of
Delivery Date Phone call to

Carrier to
confirm

delivery date

Notepad for
Carrier phone
confirmation

Computer

Invoice

Reconciling
different
inputs for

Delivery Date

Calculation of
Invoice

amount based
on Delivery

date

Telephone
confirmation
of Delivery
Date with
Carrier

Logistics Service Rep
interpretation of Delivery

Date from phone
confirmation with Carrier

Check cutting
Supervisor evaluated
on "On Time" delivery

approving delivery
datesCarrier proof

of Delivery
Date Checks

delivered to
PO

Carrier 
Invoice 

Payment 
Delays

Procedures People

Warehouse
Policies
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XY MatrixXY Matrix

XY matrix is used to:

• Identify and subjectively rank "sub-Ys"

• Relate Xs to Ys

• Take the first crack at: Y = f(X)

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
232 UNCLASSIFIED

Why Do We Need an XY Matrix?Why Do We Need an XY Matrix?

• To allow everyone involved with a process to agree on outputs 
critical to the product and/or customer

• Through numerical ranking, an XY matrix enables your team to 
assign a level of importance to each output variable

• Through association, an XY matrix enables a team to 
numerically assess the effect of each X on each Y

• It provides the team its first stab at determining Y = f(X)

• It leads the way to an area of focus on the process “Failure 
Modes and Effects Analysis” (FMEA)



OSD Greenbelt - UNCLASSIFIED 117

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
233 UNCLASSIFIED

How to Create a Useful XY MatrixHow to Create a Useful XY Matrix

Step 1:Step 1: Use available information sources like process maps to 
aid you in your identification of inputs and outputs.

Step 2:Step 2: List the output variables (Ys) along the top section of the 
matrix. These are outputs that the team and/or customer deem 
important. These may be a subset of the list of Ys identified on
the process map.

Step 3:Step 3: Rank each output numerically using an arbitrary scale 
(possibly 1 to 10). The most important output receives the 
highest number. Enter these rankings in the Output Ranking row 
of the matrix.

Lean Six Sigma
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How to Create a Useful XY MatrixHow to Create a Useful XY Matrix

Step 4:Step 4: Identify all potential inputs or causes (Xs) that can 
impact the various Ys and list these along the left side of the 
matrix. 

Step 5:Step 5: Numerically rate the effect of each X on each Y within 
the body of the matrix.

Step 6:Step 6: Use the results page to analyze and prioritize where to 
focus your effort when creating the preliminary FMEA. The XY 
matrix is a great team brainstorming tool. It can also facilitate 
future team activities.
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Revisit your Process MapRevisit your Process Map

Strip Cylinder Prep Station Remove 
Separator Deoxidize

Apply 
Separator
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Y Y Y Y
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ExampleExample

Step 2: Step 2: 
List the important 
output variables along 
the top section of the 
matrix.

XY Matrix
Project:

Date:
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ExampleExample

Step 3:Step 3:
Rank each output numerically using an arbitrary scale. A scale of 1 to 
10 is often used.

XY Matrix
Project:
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ExampleExample

Step 4:Step 4: Identify 
potential causes (failed 
Xs) that can
impact various outputs, 
and list each one along 
the left side of the 
matrix.
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Note: This captures 
what is known so far 
about the process.

NoteNote: This captures : This captures 
what is known so far what is known so far 
about the process.about the process.

Step 5:Step 5: Numerically 
rate the effect of each 
X on each Y within the 
body of the matrix.

Date:

1 2 3 4 5 6 7 8 9 10
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Output 
Ranking 5 9

Input Variables 
(X's) Association Table Rank % Rank

1 Recruiting 3 8 87 13.26%

2 Screening 2 9 91 13.87%

3 Interview 7 9 116 17.68%

4 Selection 6 7 93 14.18%

5 Offer 2 7 73 11.13%

6 Negotiation 6 6 84 12.80%

7
Initial Security 
Assessment 2 1 19 2.90%

8 Interim Clearance 6 1 39 5.95%

9 Final Clearance 9 1 54 8.23%
10
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View Results

Delete

Instructions
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Step 6: Step 6: Use the resulting ranks to 
analyze and prioritize future team 
activities. 

If no FMEA exists, the highest-
ranking inputs from the XY matrix 
should be addressed first.

ExampleExample

Input  
Variables

Rank %

Recruiting 87 13.26%

Screening 91 13.87%

Interview 116 17.68%

Selection 93 14.18%

Offer 73 11.13%

Negotiation 84 12.80%
Initial Security 
Assessment 19 2.90%

Interim Clearance 39 5.95%

Final Clearance 54 8.23%
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InIn--Class ExerciseClass Exercise

• Break into your groups 

• Use your catapult Process Map 

• Use the 6-step methodology to create an XY matrix 
(XYMatrix.xls) for the process

• Use the Xs and Ys from your process map as key information

• Be prepared to report your results

• You have 20 minutes for this exercise

Lean Six Sigma
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FMEA DefinedFMEA Defined

• Failure Modes and Effects Analysis (FMEA) is a detailed document
that identifies ways a process or product can fail to meet critical 
customer requirements (Ys)

• A living document that lists all possible causes (Xs) of failure
From this, list of items for the control plan can be generated

• A document that allows the team to track and prioritize the actions 
required to improve the process

• In short, a FMEA will:
Ultimately capture the entire process
Identify ways the product or process failed because of these Xs
Facilitate the documentation of a plan to prevent those failures
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Example:  Entitlements Project FMEA

Lean Six Sigma
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Distributions: PurposeDistributions: Purpose

• Is the basis for inferential statistics
We go from what we know to what we don’t know
We know we have sample data
We deduce that our data fits an appropriate population
We make assumptions based on each distribution

• We draw conclusions based on the shapes of these distributions
Construct a confidence interval
Test for differences in samples
Examine associations between samples
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What Good are Distributions?What Good are Distributions?

• Distributions depict the probability of a random effect occurring

• We use customer specifications to determine significance when 
compared to our observed values

• Significant events happen somewhere in the tails
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Data DistributionsData Distributions

One of the most frequently used graphic views of a data set

Normal Data 
Distribution
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Right SkewLeft Skew
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Discrete DistributionsDiscrete Distributions

• Discrete distributions differ from continuous 

Data consists of counts instead of measurements
No intermediate values 
Well-defined area of opportunity

Must have equal area of opportunity for comparison

Distributions are more ‘theoretical’
Standard deviations are a function of the means
Violates the constant variance assumption within subgroups
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Graphical Tools

• The primary graphical tools available to help characterize and 
learn about the process are:

Pareto Charts

Histograms

Time Series Plots

Control Charts

Box Plots

Cause & Effect Diagrams
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Pareto Chart

• The Pareto Chart is used to:
Separate the critical few areas from the trivial many
Focus and refine the problem statement

• Pareto Effect: 80% of the problem is due to 20% of the 
potential causes
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Pareto Chart

LQA   – Living Quarters Allowance
TQSA – Temporary Quarters Subsistence Allowance
MEA – Miscellaneous Expense Allowance

PD   - Per Diem
AoP - Advice of Payment
PA   - Per Annum
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Histogram

• Provides a snapshot of overall or average process 
performance

• Reveals variation around the average

• Measures the output against specifications or targets

• Provides some initial clues for improvement
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The Shape of Variation
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Example: Histogram
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Time Series & Control Charts

• To observe the stability of Xs and Ys over time

• Look for patterns in the data

• Identify and take action on special cause variation

• Time Series Plots/Run Charts and Control Charts are 
used to:
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Time Series or Run Chart
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Run Chart

• Shows how the process varies over time

• Shifts, trends, intermittent problems and cyclic patterns can be
detected

• Vertical-axis is the unit of measure; horizontal-axis is time

• A baseline average or current average line can be used as a 
point-of-reference to detect process changes

Lean Six Sigma
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Example: Time Series Chart
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Run Chart Procedure

• Gather data over time in sequence

• Create a graph with a vertical line and a horizontal line
The vertical line should cover the full range of measurements
The horizontal line should cover the time period which the data was 
collected
Add a baseline (using prior data) or average (current data) line to 
indicate process location (mean)

• Plot the data on the graph connecting the points

• Interpret the chart
Look for trends, patterns and/or unusual data points
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Histogram
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Two Types of Variation

• Two types of variation are visible in a Run Chart:

Common Cause
Always present to some 
degree in the process

Special Cause
Something different happening 
at a certain time and place

Lean Six Sigma
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Causes of Variation

• Predictable
• Inherent
• Part of the Process
• Must change the process to 

reduce

• Surprising
• Uncontrolled
• Often outside the process
• Must identify the source and 

eliminate

Common Cause Special Cause
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Cycle Time
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Region of Non-Random Variation

Region of Non-Random Variation

Data Over Time
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Process
Average
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Control Charts
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Control Chart

UCL= 14380

LCL= 3351

UCL= 6775

LCL= 0
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Catapult Exercise: Run Chart

• Using the data from your Histogram …create a Run Chart of 
your catapult data

Total Distance 
Azimuth Variation
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X
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x_nth

Y
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y_nth

(Response) (Factor)

Correlation

• Identify dependency  
relationships between two or 
more variables (Xs and Y).

• It is customary to call X the 
input variable (independent) 
and Y the output variable 
(dependent).
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Scatter Diagram

• Good for finding and/or confirming relationships between 
measures

• Can assist in identifying which process inputs impact the 
process output

• Add evidence to opinion regarding cause and effect

• Can identify clues for improvement
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Scatter Diagram

Scatter Diagram for Cycle Time vs Number of Inv. 
Skids
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X and Y appear to be unrelated
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Correlation Does NOT Determine Causation!

Abuse & Misuse of Correlation

• If we establish a correlation between X1 and Y, that does NOT 
necessarily mean variation in X1 caused variation in Y

• A third variable that is associated with both X1 and Y may be 
“lurking.”

• Relationship could be coincidental

• To conclude that there is a relationship between two variables 
does NOT mean that there is a cause and effect relationship.

A study conducted in New York indicated there was a proportional
rise in ice cream sales and murder rates during summer months.

Correlation or coincidence?Correlation or coincidence?
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Scatter Plots with a Discrete X Variable
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• Scatter plots with a 
discrete X variable can 
display the data in a 
useful way

• Since the data are both 
continuous (horse power) 
and discrete (automaker) 
it will stratify based on the 
categorical data
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Boxplot Distribution
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Analyzing Discrete Outputs with Continuous Inputs
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• If you have a discrete process output (i.e. pass or fail) and more than 
one continuous input variable, you can apply many of the graphs that 
have been discussed here by switching the axes on graph 
specification. 

• Graphs especially suitable for this application are boxplots and jittered 
scatter plots (note: input is on vertical axes below).
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Summary

• Brainstorming captures potential root causes through open-ended 
discussion

• Fishbone Diagram organizes potential root causes by source or category

• XY Matrix prioritizes root causes via their relationship to the output

• FMEA prioritizes root causes analytically by investigating all potential failure 
mechanisms; forms basis for control plan

• Pareto Charts show the relative magnitude of a problem

• Histograms provide a view of the process performance (location & spread)

• Run Charts provide a view of the process performance over time

• Scatter Diagrams identify or confirm relationships between measures
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Analyze Review QuestionsAnalyze Review Questions

• Based on your analyses, should you refine the project definition? 
If so, address why and communicate to the team

• Do you have an idea of what Xs may be critical to your Y?

• Are those Xs controllable? 

What Xs can be changed or addressed based on the data you currently have? 

Which will require further investigation?

• Have you communicated your findings?

• What issues and barriers exist?

Have you documented these on the action item list?

Are there any action items from Measure still not complete?
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Exercise: Catapult Performance 

• Identify and eliminate variation in the 
catapult operation

Standardize the setup and firing process

Create a NEW Process Map

• Eliminate variation in the launching 
technique

Create a NEW Process Map of the launching 
technique
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Catapult Customer

• What does the catapult customer want?

• What is their objective?

• Might knowing this give you any ideas on what you should 
measure?

• Might knowing this give you any ideas on how you should set 
up and launch your catapult?
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Improve
Define

Measure

Analyze

Improve

Control
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Improve

• Recap:
Define

You have defined the problem
Measure

You have determined the size of the problem  
Analyze

You have analyzed the data to determine the root causes where 
the improvement opportunities are

Improve
Now it’s time to take action in order to CHANGE the process and 
improve performance
Just DO IT!
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p We cannot sustain a 
visual workplace without 
5S 

Relentless
Elimination 

of Waste 
and 

Variation

5S Workplace Organization

Visual Workplace

Lean

Lean Six Sigma

Breakthrough
Technologies

p We cannot 
achieve 
breakthrough 
technologies 
without Six 
Sigma

p We cannot sustain 
Six Sigma without 
reducing variation at 
the process level

What is Lean?
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5 Lean Principles

1. Specify what creates value from the customers perspective 

2. Identify all the steps along the process chain 

3. Make those processes flow 

4. Make only what is pulled by the customer 

5. Strive for perfection by continually removing wastes 
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Lean Principles

• The goal of Lean is to compress the process time period 

• This is achieved by attacking the “8 areas of Waste”:
1. Overproduction

2. Wasted Capital

3. Poor Quality

4. Wasted Motion

5. Idle Time

6. Processing

7. Transportation

8. Inventory

The first step 
toward waste 

elimination is waste 
identification!
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Rework/Correction

• Correcting or repairing a defect in materials or parts adds 
unnecessary costs because of additional equipment and labor 
expenses

• Example:
The labor costs associated with scheduling employees to work 
overtime to re-work defects
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Overproduction

• Two types of overproduction:
Producing more products than are necessary

Producing products at a rate faster than is required

• Example:
DIA Bi-Weekly Metrics

Lean Six Sigma
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I need to see 
that first!

Why? You don’t 
have approval 

authority

Processing

• Processing work that is unnecessary because it has no 
connection with advancing the process or improving the quality of 
the deliverable

• Examples:
Printing a document to be faxed which could be forwarded as e-mail
Review steps without decision authority
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Conveyance/Transportation

• Conveyance does not directly contribute added value to a 
product. It is an incidental required action.

• It is vital to avoid conveyance unless it is supplying items when 
and where they are needed (JIT)

• Example:

Stove pipes between collection and analysis (collectors – analysts-
warfighters)

Lean Six Sigma
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Inventory

• Inventory is a drain on an organization’s overhead. The 
greater the inventory, the higher the overhead costs 
become.

• If quality issues arise and inventory is not minimized, 
defective material is hidden in finished goods.

• To remain flexible to customer requirements and to 
ensure control of product variation, we MUST minimize 
inventory.

• Excess inventory covers up unacceptable setup times, 
excessive downtime, operator inefficiency, and lack of 
organizational sense of urgency to produce product.
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Motion

• Movement of people or machinery that does NOT contribute 
added value to the product

• Examples:
Centralized printer/fax locations 
Excessive walking distance between operations
Key office personnel scattered around various locations

Lean Six Sigma
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Waiting

• Idle time between operations or events

• Examples:
An operator waiting for a machine to finish cycling
A machine waiting for an operator to load new parts
Dead time in the engineering development cycle
LSAs waiting for trouble tickets to come in
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Unnecessary Capital Investment

• Investment in plant, equipment, and systems without justification 
of need or ability to deliver

• Examples:
Building a warehouse to store extra inventory

Developing computer applications for dysfunctional manual 
processes without fixing it first

Lean Six Sigma
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The Goal

• Don’t forget the goal:
ELIMINATION OF WASTE!

With this in mind, we will introduce each of the concepts of 
lean manufacturing. 
Within each phase, our goal remains the same!
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5S Workplace Organization

• To ensure sustainable gains, start with a firm foundation
5S standards are the foundation that supports all phases of lean
manufacturing
A system can only be as strong as the foundation upon which it is built

• The foundation of a production system is a CLEAN, SAFE, and SECURE 
work environment

Its strength depends upon the employees committed to maintaining it

• Each operator must understand that maintaining these standards is a 
CONDITION of his/her employment

• As a Green Belt, you must set high goals and accept nothing less

Lean Six Sigma
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Benefits

• Process delays
• Run time delays
• Supply expense
• Recordable accidents
• Speed
• Make-ready time

• Sort through and remove clutter
• Red tag unneeded items
• Move red tagged items to a holding area
• Evaluate red tagged items
• Dispose or relocate red tagged items

• Reduce cycle time; clear/label 
workspace

• Discover hidden supplies/tools
• Reveal and remove hazards
• Remove damaged or worn parts

Metrics

1S: Sort
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Benefits
• Process delays
• Run time delays
• Recordable accidents
• Make-ready time

• Review workplace flow
• Decide where and how to keep things
• Arrange items in neat and organized patterns
• Use label, home addresses, visuals
• Make it obvious where things belong

• Reduced movement through 
labeling

• Cycle time reduction
• Reduce potential hazards
• Design in ergonomics 

compliance requirements

Metrics

2S: Set in Order
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Benefits
• Recordable accidents
• Delays
• Make-ready time

• Create a cleanup work plan - top to bottom
• Thoroughly clean entire area, including 

equipment
• Identify potential safety hazards
• Identify potential mechanical problems

• Remove debris / increase safety
• Minimize fire and spill hazards
• Preventative maintenance

Metrics

- Defining Final Solution 3S: Shine
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Benefits

• Throughput

• Latent capacity

• Establish guidelines for 5S conditions

• Establish cleanliness housekeeping standards

• Use SOPs, Checklists, Audits

• Cleanliness
• Standards for new hires
• Daily rules
• SOP for training

Metrics

4S: Standardize
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Benefits

• Throughput
• Latent capacity

• Make 5S part of daily routine

• Establish discipline

• Maintain consistency with standards

• Make it part of the culture

• Sustained improvements in 
work environment

Metrics

5S: Sustain
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1.  Get everyone involved

2.  Get commitment and authorization

3.  Set expectations

4.  Establish standards

5.  Establish daily routines

6.  Keep it simple

7.  Ensure resources are made available

Keys to Success for 5S

Lean Six Sigma
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Overall benefits of 5S

• Energizes the workforce

• Improves safety (could be 6S)

• Improves efficiency

• Improves quality

• Establishes workplace control

• Lays the foundation for autonomous maintenance
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Visual Workplace

• A visual technique for process management aids in sustaining gains

• Types of Visual Management Systems:

White Boards

Postings of daily activities

Indicator lights

Posted process flow chart with post-its to indicate position of key jobs

Posted control charts and check sheets

Lean Six Sigma
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The Visual Workplace

• The first steps of the visual workplace are the 
5S standards.

• Next, the team should ask, Can we readily 
identify:

Downtime issues?
Scrap issues?
Setup problems?
Line balancing opportunities?
Excessive inventory levels?
Extraneous tools and supplies?

• If you CANNOT readily identify these 
opportunities through a VISUAL glance of the 
area, the team should establish a means of 
immediate identification.
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• Types of documentation

Policies: give general guidance in how to handle given situations

SOPs / Standard Practices: more specific and focus on a given process, 
event, or activity.  These documents provide the “How to”

Training Documentation: operation method sheets and job aids with 
instructions structured for effective training

Policies

Procedures

Standard Practices

Records
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Standardized Work
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Prerequisites for Standardized Work

• Availability of required tools (5S):
Operators cannot be expected to maintain standard work if they are required to 
locate needed tools.

• Consistent flow of raw material:
Operators cannot be expected to maintain standard work if they are hunting 
down needed parts.

• Visual alert of variation in the process (visual workplace):
Operators and material handlers need visual signals to keep “standard work” a 
standard. If they can identify new lots of material or other variation, they can 
identify potential changes in the process. This visual check will assist in defect 
identification and reduction.

• Identified and labeled in-process stock (5S):
As inventory levels of in-process stock decrease, a visual signal should be sent 

to the material handlers to replenish this stock. Operators cannot maintain 
standard work without this.
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Breakthrough Process Strategies

• Just-in-time (JIT)
The necessary components of production arrive in the necessary quantity at the 
necessary time
Eliminates inventory

• Pull production systems
Component supply triggered by signal (e.g. Kanban card)
Replaces central planning (push system)
Essential mechanism for JIT

• Production smoothing
Mix of units produced based on sales proportions
Production sequence based on unit cycle times
Goal: “production at the velocity of sales”

• General purpose, flexible machines
Specialized tools instead of specialized machines
Enables production smoothing and quick response to variation in sales 
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More Process Strategies

• Shortened setup time 
Perform setup operations in advance of machine stop (external setup)
Convert as many setup operations to external as possible
Reduce time requirement for internal setup operations

• Process layout for shortened lead times (cell manufacturing)
Sequential processing machines laid out in a “multi-process holding line” - often 
U-shaped
Multi-function workers process units through multiple operations (v. multiple 
single function “departments”)
Tends to increase productivity, decreases WIP, balances production, reduces 
conveyance

• Autonomous defects control
Machines stop automatically when process is out of spec
Prevents mass production of defects

Source:  Toyota Production System, Yasuhiro Monden, Engineering and Management Press, 1998
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• A relentless process of identifying and eliminating waste

• An environmental framework that aids in sustaining gains

• It is comprised of 5 building concepts
Kaizen: Philosophy of Continuous Improvement

5S: A systematic method to organize, order, clean, and standardize a 
workplace… and keep it that way

Visual Workplace: A visual technique for real-time process management

Standardize: Use of documented, standardized work procedures to reduce 
variation

Breakthrough manufacturing strategies: application of relevant learning 
from other organizations to eliminate waste

Summary of Lean Six Sigma
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Building on Lean Six Sigma 

Once techniques for sustaining the gains 
are selected … it’s time to prepare for 
implementation.  

The control plan assists with the 
implementation of:

• Documentation
• Communication 
• Control methods
• Confirmation of compliance

Once techniques for sustaining the gains 
are selected … it’s time to prepare for 
implementation.  

The control plan assists with the 
implementation of:

• Documentation
• Communication 
• Control methods
• Confirmation of compliance

Mistake-Proof
Visual Workplace

5S

Standardize

Kaizen
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Areas of Focus

• Lean the process:
Cycle time 
Redundancy 
Streamline
Consolidate
Sources of Consternation

• Reduce the variation:
Attack sources of variation
Attack sources of error
Attack sources of rework

• Together these will:
Reduce effort
Increase consistency
Makes resources available for other needs

Lean Six Sigma
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Process Streamlining: Identify “To Be”

What

Where
When
Who

How

Eliminate

Combine
Rearrange

Simplify

Places
Sequences
Persons

ASK                         ACT                      IMPACT
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Lean the Process

• Validate Process Map with a “walkthrough”

• Identify Value-Added and necessary steps
Ask: “If we no longer did this, what would happen?”
For process steps that, if stopped, would negatively impact the process, mark 
“TENATIVELY” as Value-Added
For steps you are unsure of, mark “TENTATIVELY” as Non-Value-Added
Identify streamlining activities to improve process flow
Can any steps be re-routed, eliminated or combined?

• Develop “To-Be” Process Map 

• Validate “To-Be” Process Map

• Develop Implementation Plan

• Implement changes (careful, you may find some unexpected things!)

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
318 UNCLASSIFIED

• Non-Value-Added
Which activities are non-value-adding?
Which activities are not needed?
Which activities can be combined?
Which activities can be made simpler?

• Long Queues and Pauses
Where is there a long chain of tasks?
Which activities can start sooner than currently shown?

• Critical Resources
Which activities center around key functions / people?
Where are hand-offs between functions / people?
How many hand-offs?

Lean the Process
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• Wasted Space / Cycle Time
Where is wasted space?
Where are long cycle times?

• Rework or Poor Timing
Are there activities that are done more than once?
What percent of the desk-space is allocated to rework?

• Done More Than Once?
Where are similar tasks done by more than one function?

• Distances
Can distances be reduced?

• Decision Points
Due to incomplete or erroneous work / information in previous steps?
Can they be eliminated?

Lean the Process

Lean Six Sigma
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• Add cycle times to Process Map. Include:
Run Time – time to actually perform the step
Wait Time – time unit sits waiting for movement to next step
Queue Time – time unit sits waiting for processing
Changeover Time – time to change from one unit to next unit

• Look for opportunities to reduce cycle time by:
Eliminating steps
Changing the sequence of steps
Eliminating/minimizing movement between steps
Etc.

Lean the Process
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EEOC
OSHA

EPA

Necessary Steps

• A step may be non-value-added but 
necessary if:

Required by law, regulation, or contract
Required for safety, health, environmental, 
or ethical considerations

FISMA

DFAR
Environmental Protection Agency
Defense Federal Acquisition Regulation
Equal Employment Opportunity Commission
Occupational Safety and Health Administration
Federal Information Security Management Act

Lean Six Sigma
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Mistake-Proofing Agenda

• The relationship between errors and defects
• Types of errors
• The arguments for mistake-proofing
• Mistake-proofing versus inspection
• Mistake-proofing concepts
• Mistake-proofing techniques or devices
• Exercise

Mistake-proofing: using knowledge and ingenuity 
to create devices that allow you to do your job 
100% defect/error free 100% of the time
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• Home
Automated shutoffs on electric 
coffee pots
Ground fault circuit breakers for 
bathroom inside or outside 
electric circuits
Pilotless gas ranges and hot 
water heaters
Child-proof caps on medications
Butane lighters with a safety 
button

• Factory
Dual palm buttons and other 
guards on machinery

• Office
Spell check in word processing 
software
A “Do you want to delete?”
message after you press the 
“Delete” button on your 
computer

• Automobile
Seat belts
Air bags
Car engine warning lights

• Retail
Tamper-proof packaging

Examples of Everyday MistakeMistake--ProofingProofing

Lean Six Sigma
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Mistake-Proofing

• Forgetfulness (not concentrating)
• Errors due to misunderstanding (jumping to conclusions)
• Errors in identification (viewing incorrectly- too far away)
• Errors made by untrained workers
• Willful errors (ignoring rules)
• Inadvertent errors (distraction, fatigue)
• Errors due to slowness (delay in judgment)
• Errors due to lack of standards (written and visual)
• Surprise errors (equipment malfunctions)
• Intentional errors (sabotage- least common)
• Errors due to fatigue Poor Communication 

is the #1 cause of 
mistakes 
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• There are an infinite number of methods to mistake-proof a process 
including:

Performance Step Techniques
Fixed-value Techniques 
“Make it easy to do it right” Techniques

• Be creative and imaginative!

Mistake-Proofing Methods

Lean Six Sigma
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• Performance Step Techniques
Require “monitoring” the process to insure the proper steps are 
followed, and triggering an outcome if the step is not performed
correctly.
Examples:

eZHR Appraisal System
Online expense reporting systems

Mistake-Proofing Methods
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• Fixed-value Techniques 
Involve setting conditions for a process step (input) and counting to 
that value
Triggers can occur when the count is not achieved (over or under) or 
the trigger can’t occur unless or until the count is achieved
Examples:

Paying for a fixed amount of gasoline before pumping
Debit cards

Mistake-Proofing Methods
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• “Make it easy to do it right”
True process mistake-proofing techniques are hard to put in place 
due to cost or effort associated 
In such cases, mistake-proofing “aids” can be used to “make it easy 
to do it right”
These techniques are not truly 100% mistake-proofing but they can 
prevent mistakes from occurring
Examples include:

Color coding
Tire wear stripe

Shapes
Different shaped electrical plugs for different voltages
Tool shapes on a tool board

Operator-initiated “auto-detection” systems
Sheet scanners for density and/or register with triggers
Control charts for inputs and outputs

Mistake-Proofing Methods
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Mistake-Proofing

• What kinds of mistake-proofing do you see here?

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
330 UNCLASSIFIED

• Other Tools
Checklists
Forms
Posted SOPs and/or schematics
Simplified workflow

• Keep them simple and short (1 page) or they will not be used

• Simplified workflow is always a more desired state

• A picture is worth a thousand words

Transactional Mistake-Proofing
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Implementation Plan

• An organizational tool that allows a Black/Green Belt to lay out
their thoughts, leading to an efficient flow of action

Compiling initial concept questions leads to both parallel and 
serial activities 

Include all necessary action items that can aid in the success of 
the project

Graphically represent your approach in a manner that others can 
follow

Lean Six Sigma
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Goal of Implementation Plans

• Imbed sequential work within a parallel thought process

• Resolve questions prior to developing solutions

• Identify necessary items on a “Macro” level

• Assign responsibility for completing and monitoring to the 
correct individuals

Focus on parallel tasking!
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Implementation Plan

• Changes cannot be made until there is a plan 
(We do not plan to fail, we fail to plan, which often results in Failure)

• Implementation plans -
Includes timing, responsibility, involvement of key stakeholders, 
and key milestones

Large tasks are divided into subtasks and outcomes defined for 
each subtask

Includes regular status reviews of the plan

Entire implementation team involved in creating the plan

Tools include: Action Item Register

Lean Six Sigma
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Project Plans

• Several tools can help you create a project plan
• If you are not familiar with Microsoft Project, use Excel
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Implementation Plan

• Responsibility, involvement, and key stakeholders

D = Driver
Change agent
Drives process improvement via Lean Six Sigma

A = Approver
Process owner
Responsible for area impacted by project 

C = Contributor
Who should be consulted regarding changes in the process

I = Informed
Who needs to be informed regarding process changes

Lean Six Sigma
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Monitoring results

Implementing the 
solution

Handling potential 
problems

Planning the 
implementation

Selecting Solutions

Identifying solutions
InformedContributorApproverDriver

Task
Which groups or individuals should be…

Implementation Plan

• Organize your implementation plan to ensure the correct people 
are assigned to the right tasks
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• Identify what you want to accomplish
• Identify the actions needed
• Estimate the time and resources required

For each action
For people, equipment, supplies, money

• Identify measures of progress
Is the plan working?
Are we getting the desired results?

• Identify potential problems and how to deal with them
• Create a document that captures the plan

Implementation Plan Procedures

Lean Six Sigma
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Action Item Register (AIR)

• An action plan to help us link:

Problem Analysis
of Problem

Root Cause
of Problem

Corrective
Action

Evidence of
Improvement Control

• Helps prioritize and track problems and issues 
• Ties to Pareto Charts (especially 2nd level) on reports
• Basis for Customer Scorecard, Action Plans, and Forecasted 

Improvements
• Helps define resource requirements
• Identifies responsible person(s)
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AIR Problem Type

Type 1 Problem within the immediate control of the Process 
Supervisor and Team

Type 2 Problem not within the immediate control of the Process 
Supervisor and Team but can be resolved with help from 
resources inside the division

Type 3 Problem for which Team or internal resources cannot 
identify the true root cause or permanently fix
• 6 Sigma Green Belt projects
• Involve outside suppliers/equipment vendors

Lean Six Sigma
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AIR Example

Date Task 
Complete Task Action 

Date Due Date Week Day +/-  
0

Team 
Member(s)

Check 
Complete Notes

08/24/06 Update Action Register and post on group share
08/24/06 Email notification to CS3 Team informing them of Action Register update:
08/24/06 Outlook:\\Public Folders\All Public Folders\DIA\CS-3\CS-3 Contacts

08/29/06 Enough seats to accommodate 60 people at DIAC
08/29/06 Ensure room has JWICS and NIPERNET connectivity
08/26/06 Ensure room has laptop connectivity
08/29/06 Ensure Room Access Code

Schedule out for next 12 months (see attached schedule for course dates)
Determine agenda (GB Briefers, GB Learning Session, Group Dialogue)
Confirm invitee list
Confirm briefers (2 per MBB suggestion)
Confirm facilitator for learning session

09/05/06 Contact briefers and associated MBBs via telephone or in person
09/05/06 Email GB Calibration notice (date, time, place, and briefing template attachment):
09/05/06 Outlook:\\Public Folders\All Public Folders\DIA\CS-3\CS-3 Contacts

Acton 
Cantwell
DeLaroderie

A1 08/24/06 Update Action Register Wed

08/23/06 08/23/06A2 Room Reservation

A3 Invite Green Belts

A4 GB Brief Prep

Wed 21 Rollins

14Wed

Fri 13 Work with briefers in preparation for GB Calibration meeting

21 Rollins

09/08/06

08/23/06 08/23/06

08/30/0608/30/06

08/31/06

Johnson

Rollins
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Improve Phase Review Questions

• Do your improvements address the root causes of the problem?

• Have you mistake-proofed your improvements?

• Do you need to run a pilot?

• Did your team contribute to the improvements?

• What is the implementation plan?

Lean Six Sigma
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Improve ExerciseImprove Exercise

TO: Product Calibration Teams
FROM: Mr. Topper, DD4, 007 Projects Division
CC: Performance Management Group  
SUBJECT: Cat-A-Pult Working Instructions for Acme Weapons, LLC

• Acme Weapons LLC, a long-time customer, uses our product as part of its 
ongoing mission and relies on us to provide an accurate and reliable product 
every time.  After extensive interviews and coordination efforts with Acme, we 
have identified specific customer demands regarding the functionality of our 
Cat-A-Pult product.   

• Because we have to be responsive to customer demands, we will insure that 
our product arrives at the customer meeting the following defined operational 
parameters:

Set-up: Rubber band must connect from catapult launch arm, over the tension 
adjustment pin, connecting to the anchor pin connecting to the bottom of the 
catapult.

Accuracy: Customer must be able to achieve an impact within 3” of a target that is 
60”-120” from launch site.  Vendors will be required to demonstrate their catapult 
five (5) times and achieve an 80% or greater success rate to be deemed successful.
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Control
Define

Measure

Analyze

Improve

Control

Lean Six Sigma
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Change

Definitions of Insanity:

“Doing the same thing over and over and 
expecting a different outcome!”

…and

“Using the same logic to get you out of trouble 
that landed you there in the first place!”

-Albert Einstein

? # $ * ! ?
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How to Sustain the Gains

• Change
Remember Albert?  Don’t Be Insane
Change is uncomfortable for most people
Change takes time to take hold and become routine

• New Instructions
Ensure there are clear SOPs where accountability has been assigned
Ensure there are clear work instructions

• Identify Measures 
Measures must now be converted to Metrics and monitored 
Ensure you have a response process should performance dip   

• Training
Ensure everyone is informed and trained on the changes

Lean Six Sigma
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Control Plans

1. Define the Solution
2. Document the Standard Practice

• Who, What, When, Where, Why, How
3. Established Data Collection Process
4. Determine Control Tools
5. Create Training Documentation
6. Communication & Training Plan

• Communicate & Train
• Who, What, When, Where, Why, How

7. Audit Procedures
8. Corrective Action Reports
9. Project Documentation
10. Translation of Learning (s)
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• A critical piece of a control plan is the process of monitoring 
the process output

• Control Charts are ideally suited for data monitoring because 
they tell us: 

If a process is stable
The level of variability from data-point to data-point, over time, 
relative to the central limit theorem  
About process trends
Special Cause occurrence 

Control PlansControl Plans

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
350 UNCLASSIFIED

Concept of a Control ChartConcept of a Control Chart

Data Over Time

Region of Non-Random Variation

Region of Non-Random Variation

Region of Random VariationRegion of Random Variation Common Cause Common Cause 
VariationVariation

Special Cause Special Cause 
VariationVariation

Special Cause Special Cause 
VariationVariation
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• Center Line
Average or Mean
Median
Other

• Upper Control Limit
A boundary 3σ above the center line

• Lower Control Limit
A boundary 3σ below the center line

Control ChartsControl Charts

Lean Six Sigma
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Region of Non-Random Variation

Region of Non-Random Variation

Data Over Time

Upper
Control
Limit

Process
Average

Lower
Control
Limit

Control Charts
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Out of Control

In Control

Sample Number

Region of Non-Random Variation

Region of Non-Random Variation

Region of Random VariationRegion of Random Variation

Upper
Control
Limit

Process
Average

Lower
Control
Limit

Control Charts

Learn From Learn From 
TheseThese

Sample Number
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Continuous 
data
or

Attribute Data?

Choose Variable
Control Chart

Choose Attribute
Control Chart

Continuous Attribute

Control Charts

• The type of control chart used depends on the nature of the data
being charted:

Variable or Continuous Data
Measures

Attribute Data
Counts
Yes or No



OSD Greenbelt - UNCLASSIFIED 178

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
355 UNCLASSIFIED

Variable Control Chart Desired

Can rational
subgroups be

formed?

Are the 
data normally
distributed?

Need 
sensitivity to small 

changes?

Choose I, mR charts

Charts
R ,X

 Choose

Charts
mR ,Xm

Choose

yes

no

yes

no

no

yes

What is the
shape of the
histogram?

Near
Normal

Symmetric
non-normal Skewed

n= 2 or 3 n= 4 - 5 n= 5 - 10

Control Charts

Lean Six Sigma
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Attribute Control Chart Desired

Are the Data
Yes/No or count?

Is sample
size constant?

Is the area 
of opportunity

constant from sample
to sample?

Yes/No Count

yes no yes no

50)1(5
and

 505
chart  or chart 

Choose

≤−≤

≤≤

pn

pn
pnp

50)1(5
and

505
chart 

Choose

≤−≤

≤≤

pn

pn
p

505or
505
chart  or chart 

Choose

≤≤
≤≤
un

c
uc

505
chart 

Choose

≤≤ un
u

Control ChartsControl Charts
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• For Variable data, three basic pairs of charts exist:
1. I,MR: Individual and Moving Range 
2. Xbar,R: Average and Range
3. mXbar, mR: Moving Average and Moving Range

• For Attributes data, four basic charts exist:
1. nP: Number chart
2. P: Proportions chart
3. C: Count chart
4. U: Rate

Control Charts

Lean Six Sigma
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Project Action Item Register

PROJECT DESCRIPTION LEAD RESOURCES PROBLEM STATEMENT
NATURE OF 

DEFECT CORRECTIVE ACTION PLAN DUE DATE PROGRESS
DATE 

UPDATED

Calibrate temperature control 
system on all units. John Doe

Supplier
Ellen Technician

Independent measures of ink 
temperature do not match those on 
the consol. Each is off by different 
amounts. 

Variant temps 
between the units 
causing print 
defects.

John will contact supplier re: 
problem, Ellen will use manual to 
attempt to reset control system 
and calibrate. 12/14/1999

Completed 
11/29/99 11/29/1999



OSD Greenbelt - UNCLASSIFIED 180

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
359 UNCLASSIFIED

AIR Example

Root Cause Analysis What Action          
Who (Name)

Mis ship pallets - 
outbound skids left in 

rack
2500 1

Physical inspection of 
warehouse,Que detail 
report, Inventory Error 

messages

scanning pallets 
before loading, 8125 
or postage issues, 

could not find pallets

Frank gives 
counseling on 

individual basis, 
discuss topics in pre 

shift meetings

3/12/2002 3/20/2002
Number of Mis-
shipped pallet 

sreduced by 15%

PRESHIFT MEETING ON 
THE IMPORTANCE OF 

SCANNING PRODUCT AS 
YOU LOAD THE TRUCK.

Improper scanning - not 
watching screen of 
scanner- incorrect 

manual input - manual 
keying

1892 1 excessive error 
messages

drive by scanning, 
skids not in active 

inventory

Supervisor (Greg) 
discussed porper 

ways of scanning in 
daily  Pre-shift 

meeting

3/21/2002 3/21/2002

Improper 
scanning and 
manual input 

decreased

supervisor is monitoring to 
make sure employees are 
not scanning inventory on 
forklifts, unless they are in 

the cage scanning the 
upper levels

Not following 
procedures - product in 
rack not scanned - Lack 

of training

1620 1

inventory not scanned 
report/Inventory error 

messages, manual 
keying

Lack of 
training/Improper 

checking of product

Sal will conduct pre-
shift meeting on the 

importance of 
scanning anything 

that is moved out of 
location

4/1/2002 4/17/2002

SOP helped new 
emoployees 
identify the 

process

preshift meeting on the 
proper way to put away 
product, manual keying 

prohibited.

Control      
Plan

Action 
End 
Date

 FMEA 
Results Type Improve

AnalyzeDefine      
The Problem

Measure
Action 
Start 
Date

• Your AIR will serve as the foundation of your Control Plan
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• What data needs to be gathered?
Primary metrics
Secondary metrics
X data

• What form should the data take?
Paper
Electronic

• How often should each measure be assessed (Gage R&R)?

Control Plans: Data Collection/Documentation
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• Utilize ANY and ALL communication vehicles:
Memo
E-Mail
Town Hall Meetings
Small Group Meetings
Newsletter
Flyer
Video/DVD
Web Page

Control Plans: Communicate & Train

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
362 UNCLASSIFIED

• Effective audits must be a function used by management
The purpose for the audit should be well defined

• Auditors must be qualified to perform their tasks
Confirm auditor can perform audit without bias
Auditor must understand importance of CPI and Standardization

• Measure against a defined standard
Audit is to be performed against written standard operating procedure

• Contain conclusions based on fact
Utilization of an effective checklist assures scope and content of audit

• Provide reports that focus on the control system
The audit should confirm or refute the control systems work

Control Plans: Audit

Auditing is a process for evaluating compliance to written requirements 
and the effectiveness of those requirements in meeting basic 
management controls. The evaluation compares reality to requirements.
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• Review the Standard Practice
• Create a checklist to confirm the process is being followed and includes:

Review of Training Records
Including maintenance of Training Records

Questions/Observations that encompass the entire scope of the standard 
practice

Use as many open-ended questions as possible
Specifics on what to observe

This could include yes/no answers to observations
Data collection procedures

Control Plans: Audit

Lean Six Sigma
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Objectives:
• Document significant non-conformities

• Identify a problem and isolate the underlying cause

• Find a solution for the cause of the problem and develop a plan to 
implement the solution

• Document the Corrective Action Plan

• Establish a schedule of when actions are 

to be initiated and completed

Control Plans: Corrective Action
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• Corrective Actions represent systematic issues or conditions

• The following always result in a Corrective Action:
Customer Complaints

Failure to meet Customer expectations

Significant internal or third party audit findings

Deviation from documented Standard Practices or Procedures

Statistical data or trends indicate the need

Control Plans: Corrective Action

• An effective Corrective Action is:
• Timely
• Effective
• Prevents the recurrence of a problem! 
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• Implement immediate containment solution
• Create an intervention step as a short term solution:

Allows problem to be managed during investigation
Appropriate steps may be inspection and/or increased supervisor 
involvement
Stop-gap measures ensure the problem does not reoccur

Control Plans: Corrective ActionControl Plans: Corrective Action
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• Next, Transfer ownership of the project to the Process Owner
• Ensure Division Director is aware of the transfer data
• Ensure the Process Owner:

is aware of the transfer data
has been fully trained on all aspects of the control plan
is completely aware of his/her responsibility to maintain the 
control plan going forward
is aware of the reporting responsibilities going forward

Leave NO question in ANYONE’S mind 
that project and process ownership have changed!

Control Plans: Translate & Document
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Example: Example: Project Project 
Control Plan DocumentControl Plan Document

• Creative applications of tools used in other ways during the process
Control Plan # 

Date (Original): Prepared by:
Black Belt Key Contact

Control Plan for: Date (Revised): Process Manager

Champion Approval:

Division: Audit Frequency By Supervision By Dept Manager By CIM By Corp CIM Stakeholder Approval:

 Date of First Audit CI Manager Approval:

  Division Director Approval:

Process Process Step Required Action
Process Specification (LSL, 

USL, Target)
Measurement 

Technique Sample Size
Sample 

Frequency Control Method Reaction Plan

Audit Details

Sample AuditProcess Measurement

                                                 SIX SIGMA CONTROL PLAN
Equipment / Process
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Example: Process
Control Plan Document

Process Control # ( 
Issued #)

Target

Process 
Step

Specificatio
n - UCL/LCL, 

Target etc.

Operational 
Measure

Control 
Chart

Audit 
Frequency

Audit Date

SOP # SOP DISC Metric Size Freq.

Any Special Tools 
required or needed

Specific to 
Item

ISO 
Format

Explanation
 of ISO #

Key Variation
of product

Spec of Item
being controlled

Specifics for data
measurement # #

Type of 
Control 

Chart used

Specify the Audit 
Freq of each line 

item

Date of last 
Audit

Obtain Strategic Plan 
from COO

Strat Plan 
Review

CW-122-
2

ID CTB 
Objectives BU Specific .05 % of Target EBIT 4

1per 
QTR I-MR

QTRLY Report
1st week of 
each new 

QTR

Metric Review
Establish 
metrics SW-567

Tie CTB 
Objectives to 

KPIs BU Specific 0.05% EBIT 4
per 

QTR I-MR
Monthly Report

2nd week of 
each new 

QTR

Division Director Approval:

Department Manager Approval:

Date Revised

Hand Off Date:  CI Approval/Date: BlackBelt and or CI Mgr.

Original Date:   
May 21, 2003

Process Name:  Metric Review Process Owner:    Director of Continuous 
Improvement                                                                   

MBB  Approval  - Jesse Johnson

Actual Item of Control  
(WHAT)

Process Control Items 
Reference of Process Item
(Exhibit, Work Instruction, SOP,  

Etc.)
SampleProcess, Machine, 

Equipment

Machine Number or 
Equipment I.D.

Action Item Control 

Catelog Retail 
Business Unit

Catelog Retail 
Business Unit

Lean Six Sigma
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Control Plan # 704-1 Glasgow Division, R.R.Donnelley & Sons
Product: KE 704 Strapper/Stacker Stops  Date (Original): Prepared by:
Key Contact: Jerry Springer (ext. 138) Stan Mills (ext. 257) Jerry Springer
Core Team: Donnie Bunch, Mike Chapman, Wes Gentry, Bobby Jessie, J.T. Mitchell, Wayne Smith, Sanford Syra, Steve Webb  Date (Revised):
Champion: Marlin Harker            Stakeholder: Drew  Coxhead

Control Plan for: Attachments: SOP - 015 Champion Approval:

KE 704 Oval Strapper #1 Performance Level SOP - 025 Stakeholder Approval:

 CI Manager Approval: Jesse Johnson

  Key Facilitator Approval:

Process Process Step Recommended Action
Process Specif ication (LSL, 

USL, Target)
Measurement 

Technique
Sample 

Size
Sample 

Frequency Control Method Reaction Plan

Binding Makeready

Set up strapper using 
settings established as result 

of DOE 

Strapper settings listed on 
daily strapper stop 

checksheet and in KE 704 
SOP - 015

Key Facilitator 
measure adherence 

per PVR audit N/A
Each 

Makeready PVR Audit

Key Facilitator document 
and review  w ith Craft 
person involved in non-

adherence

Binding Makeready

Set up cardfeeder using 
settings established as result 

of DOE
Cardfeeder settings listed in 

KE 704 SOP - 025         

Key Facilitator 
measure adherence 

per PVR audit N/A
Each 

Makeready PVR Audit

Key Facilitator document 
and review  w ith Craft 
person involved in non-

adherence

Binding Run

Record all strapper stops 
(cause and delay time 

involved) on shift strapper 
stop checksheets

Procedure outlined in 
strapper stop manual at 
Assistant Operator desk

Key Facilitator 
measure adherence 

per visual audit N/A Shift Visual audit for compliance

Key Facilitator document 
and review  w ith Craft 
person involved in non-

adherence

Training Crew  Training

Train new  704 Craft on 
standard MR strapper 

settings. 

Strapper settings listed on 
daily strapper stop 

checksheet and in KE 704 
SOP - 015

Key Facilitator 
measure adherence 

per PVR audit N/A
Each 

Makeready PVR Audit

Key Facilitator document 
and review  w ith Craft 
person involved in non-

adherence

Training Crew  Training

Verify all Vacation/Overtime 
coverage Assistant 

Operators (non 704) of 
standard strapper settings

Strapper settings listed on 
daily strapper stop 

checksheet and in KE 704 
SOP - 015

Key Facilitator 
measure adherence 

per PVR audit N/A
Each 

Makeready PVR Audit

Key Facilitator document 
and review  w ith Craft 
person involved in non-

adherence

                                                 KE 704 SIX SIGMA CONTROL PLAN

Example: Process
Control Plan Document
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Target
Machine, 
Device, 
Tools

For Mfg.

Responsibility:
Name/Phone

Specificatio
n Measurement

Control 
Method

Responsibility:
Name/Phone

Date

No. Product Process Size Freq.

Specific to 
Item

ISO 
Format

Explanation
 of ISO #

Key Variation
of product

person
assigned 

Spec of Item
being controlled

Specifics for data
measurement # #

Specifics for data
Control

person
assigned

Clamp
truck

01,02,03,
04,05 WI-029-30-..

Damage
Prevention

Monica Campbell
Ext. 3894

Every Hoist 
Operator

Receipt of Train-
ing document

Sign form before 
leaving class

Rob Wenning
Ext. 3844 1.26.01

Clamp
truck

01,02,03,
04,05 WI-029-30-..

Damage
Prevention

Rob Wenning
3844

Written & Visual
criteria

Check-Off 
List

Allan Fairchild
Ext. 3738 2.9.01

Clamp
truck 01, 03 WI-029-30-..

Transport Roll
TD Inspection

Allan Fairchild
Ext. 3737

Written & Visual
criteria

Check-Off 
List

Allan Fairchild
Ext. 3739 2.16.01

Clamp
truck

AU-001
,2,3,,4,5

Audit WI-029-
30-001,2,3,4,5 Audit Form

Dar Meredith
Ext. 3952

Leads, 
Coordinator
& Receiver

Check-Off 
List Pass / Fail

Allan Fairchild
Ext. 3738 2.23.01

Clamp
truck

Audit WI-029-
30-001,2,3,4,5 Audit Form

Materials Dept.
Leads

Every Hoist 
Operator

Check-Off 
List Pass / Fail

Allan Fairchild
Ext. 3738 2.28.01

Clamp
truck 01, 03 WI-029-30-..

Transport Roll
TD Inspection

Allan Fairchild days
Leads nights

Check-Off 
List Pass / Fail

Allan Fairchild
Ext. 3739 3.12.01

5) Hoist Operator
 Audit

6) DLS Driver
Audit

Actual Item of Control

1) Train Operators 
on SOP'S) &
Coordinator
Create Audit Text

4) Leads
 Audit

3) Text created
for DLS  Audit 

Action Item Action Item Control 

Process Name/
Operation

Description

Reference of Process Item
(Exhibit, Work Instruction, SOP,  Etc.) Sample

Approved By  - Jesse Johnson Black Belt:Name/Phone

Rob Wenning Ext. 3844

Champion: Name/Phone

Gail Millward Ext. 3850
Other Approval/Date: As needed, Example DD, HR, ENG.

Control Plan Number:ISO format

CP-029-30-001A
Core Team Members: Reference for future of Team know ledge 

& Involvement Dario Cruz, Skeeter Dominguez, Dar - 
CI Approval/Date: BlackBelt and or CI Mgr.
Rob Wenning 1.30.2001

Meredith, Dennis Lancaster, Troy Valentine  Department Mgr. Approval/Date: Ultimately responsible person for compl
Gail Millward 1.30.2001

Control Plan Product Name:
Plant Damage

Process Owner:Name/Phone Person assigned by Dept. Mgr. Responsible for 

overseeing plan                                                    .Gail Millward  Ext. 3850               

Date: Original
1.30.2001

Date:Revised

Example: Process
Control Plan Document

Lean Six Sigma
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Summary

Control plans must identify:
What we are measuring
How we monitor 
What we do when the process is out of control

“I have been impressed with the urgency of doing. 
Knowing is not enough; we must apply. 
Being willing is not enough; we must do.”

Leonardo da Vinci
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Analyze
Define

Measure

Analyze

Improve

Control

MMIINNIITTAABB

Lean Six Sigma
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AgendaAgenda

• Introduction to Minitab window and icons
• Time Plots

Stratified Time Plots
• Run Charts
• Histograms and Dot Plots
• Box Plots
• Scatter Plots
• Pareto Charts
• Individual Control  Charts
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Minitab WindowsMinitab Windows

• Session 
Only shows text.
It shows log of work performed 
including commands and graphs, 
and data analysis results.

• Project Manager
Lists all Worksheets, Sessions, and 
Graphs in the current Project.
Can be used to re-name any 
window within the Minitab Project 
(graphs, worksheets, etc.).

• Worksheet 1 
Looks like MS Excel.
Data goes in this window.
Data MUST be in column format.
Columns should be labeled on first 
row (shaded row).

Minitab opens three windows when launched:

Lean Six Sigma
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Minitab Icons

1. Open Project (not a worksheet)
2. Save Project (not worksheet)
3. Print (contents of Active Windows)
4. Cut
5. Copy
6. Paste
7. Undo
8. Redo
9. Bring up last dialog box (repeats last request or command)
10. Move up in the Session window
11. Move down in the Session window
12. Find or look-up (similar to search in MS Office)

1    2     3     4    5    6    7    8     9    10  11  12   13 14  15     16  17 18 19              20        21 22  23 24  
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Minitab Icons

13. Cancel Command (useful when Minitab locks up during calculation or takes 
too long to come up with analysis)

14. Help
15. Statistical Guide (explains statistical concepts related to the last command or 

calculation preformed)
16. Session icon (brings the Session window to front)
17. Worksheet icon (brings the active Worksheet to front)
18. Plot icon (brings the Graphs to front)
19. Show Information (describes contents of current Worksheet)
20. Related Documents icon (stores related links)
21. Go to Session Window (goes to the Session window)
22. Go to Data Window  (toggles between all Worksheets)
23. Project Manager Window (goes to Project Manager view)
24. Close All Graphs (deletes all graphs in current Minitab Project)

1    2     3     4    5    6    7    8     9    10  11  12   13 14  15     16  17 18 19              20        21 22  23 24  
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Graph Editing Toolbar 

1. Select Graph Element (i.e. axis label, graph title, etc.).
2. Edit Select Graph Element (allows user to edit the graph element).
3. Select Mode (user can point-and-click to select graph elements).
4. Brush Mode (to identify points on a graph [identification shows in the 

Brushing window]).
5. Crosshair Mode (shows coordinates of any point in a graph).
6. Add List (adds elements to a graph i.e. reference line, etc.).
7. Delete (deletes selected graph element).
8. Zoom (zoom on graph).

1               2     3   4   5                        6        7    8 
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Importing Data

• Open catapult Excel worksheet Wave_7_Catapult.xls.

• Notice:
Data on screen may not match current Wave data.

Lean Six Sigma
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Importing Data

• Start Minitab and open Excel worksheet Wave_7_Catapult.xls:
Go to File > Open Worksheet.
Change “Files of type:” to Excel(*.xls).
Search and open file.
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Importing Data

• Notice:
The Title Row (gray row) is empty
Column 1 is empty
In Columns 2 and 7 the dates are not in the proper format
When you scroll down you can find the Total, Mean, and Std. Dev. values
This worksheet is NOT USABLE for analysis in Minitab!

Lean Six Sigma
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Importing Data

• Rules to Remember when importing data from Excel:
Data should be in “column” order
Place column titles on the first row (don’t repeat titles!)
Do not use special format numbers ($, %, etc.).  Minitab will assume that the 
numbers are “text.” Also, don’t have multiple rows of titles (e.g. C3-T)
Do not use cells to calculate Total, Mean, and Std. Dev., etc.  Minitab will 
assume they are just one more data point (and skew your data!)
If you use formulas, realize that Minitab will only copy the calculated value -not 
the formula

• Close worksheet Sheet1:
Click on the “X” button on the  
top-right corner of the worksheet
If asked to save the worksheet 
click on “No”
A new worksheet should 
automatically appear (Sheet2)
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Importing Data

• Go to the catapult Excel worksheet Wave_7_Catapult.xls
• Highlight the cells containing the groups data
• Copy only the “relevant data”
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Importing Data

• Go to Minitab and paste the Excel data
Paste starting on the top-left corner gray cell

Right-mouse click on the cell and select “Paste Cells”
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Importing Data

• Notice:
Columns 1 and 6 end with “-D” which stands for date
Columns 4 and 9 end with “-T” which stands for text
Other columns (C2, C3, etc.) end with the column number which means 
that they are numerical columns
Minitab re-titled Column C6-D as Time Stamp_1

• Excel data should now appear in the Minitab worksheet

Lean Six Sigma
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Data Format

• Numerical
Positive or negative numbers 
expressed in decimal format

• Date 
Calendar dates that can be 
expressed in various formats   
(i.e. mmm-yy, dd-mm-yy, etc.)

• Text
Any combination of letters and 
numbers
Minitab will not recognize these 
cells as having numerical values

To change data format:
• Data>Change Data Type

The only THREE data formats are:
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Time PlotTime Plot

DEFINITION: Graph of data in time order

TASK: Create a Time Plot of T1-Distance:
• Graph>Time Series Plot>Simple
• Select Simple plot - Click OK 
• Click inside the Series box - Select T1-Distance
• Click OK
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Time PlotTime Plot

RESULTS:
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Time Plot: Date LabelsTime Plot: Date Labels

TASK: Re-generate Time Plot with date labels:
• On the toolbar click the icon “Bring up last dialog box” (#9) or use “Control-E”

• Click Time/Scale button>Time tab>Stamp button
• Click inside the Stamp dialogue box>on the left, double click Time Stamp

column to make it appear in “Stamp columns” dialog box
• Click OK twice to generate the graph
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Time Plot: Date Labels

RESULTS:
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Time Plot: Chart Points

TASK: Get Time Plot with chart points information: 
• From the Graph Editing Toolbar select Brush Mode

• Click Editor>Set ID Variables…>Select Columns>OK
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Time Plot: Chart Points

RESULTS:
• Select the first five data points 

on graph by dragging mouse 
and creating box over them

• Data points information will 
appear in the Brushing window 
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Time Plot: Stratified

TASK: Plot all five teams distance data in the same graph: 
• From the Graph Editing Toolbar select “Select Mode” (the arrow icon)

• Click Graph>Time Series Plot>Simple
• Click inside Series box. Select T1-Distance, T2-Distance, T3-Distance,          

T4-Distance, and T5-Distance
• Click the Multiple Graphs button and select the Multiple Variables tab. Select 

“Overlaid on the same graph.” Click OK twice
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Time Plot: Stratified

RESULTS:
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TASK: Make Stratified Time Plot with separate lines for each team 
in separate panels:  

• On the toolbar click the icon “Bring up last dialog box” (#9) or use “Control-E”

• Select Multiple Graphs button>Multiple Variables tab 
• Select “In separate panels of the same graph” and check “Same Y”
• Click OK twice

Time Plot: Stratified
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Time Plot: Stratified

RESULTS:
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TASK: Make Stratified Time Plot with separate graphs for each 
team:

• On the toolbar click the icon “Bring up last dialog box” (#9) or use “Control-E”

• Select Multiple Graphs button>Multiple Variables tab 
• Select “On separate graphs” and check “Same Y”
• Click OK twice

Time Plot: Stratified
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Time Plot: Stratified

RESULTS:
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Time Plot: Stratified

TASK: Stratify T1-Distance by T1-Pass/Fail:
• Click Graph>Time Series Plot>With Groups
• Select T1-Distance as Series
• Select T1-Pass/Fail as Categorical Variables for Grouping
• Click Time/Scale tab - Select Time Stamp for Stamp 
• Click OK twice

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
400 UNCLASSIFIED

Time Plot: Stratified

RESULTS:
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Run Chart

• Go to the Stat menu:
Go to Quality Tools

Select Run Chart

Alternate to Time Series Plots
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Run Chart

TASK: Create Run Chart for T1-Distance:
• Select T1-Distance as Single column box
• Set Subgroup Size to 1 
• Click OK
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Run Chart

RESULTS:

Observation

T1
-D

is
ta

nc
e

2018161412108642

160

150

140

130

120

110

Number of runs about median: 10
Expected number of runs: 11.00000
Longest run about median: 5
Approx P-Value for Clustering: 0.32295
Approx P-Value for Mixtures: 0.67705

Number of runs up or down: 14
Expected number of runs: 13.00000
Longest run up or down: 3
Approx P-Value for Trends: 0.71094
Approx P-Value for Oscillation: 0.28906

Run Chart of T1-Distance
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Histograms & Dot Plots

DEFINITION: Histograms and Dot Plots are “Frequency Plots.” They are 
used to show the average, spread, and shape of the data distribution. 

TASK: Create histograms for T1-Distance and T2-Distance
• Go to Graph menu > Histogram >Select Simple
• Click in the Graph variables box and select T1-Distance and     

T2-Distance as the variables to plot
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Histograms & Dot Plots

RESULTS:
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Histograms

TASK: View the graphs side-by-side
• Select the Show Graphs Button

• Select both histogram charts in the Project 
Manager window

• Right mouse click and select Tile
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Histograms

RESULTS:
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Histograms

TASK: Plot all five histograms on a single chart:
• Click the Show Graphs button until the Project Manager is shown without graphs.

• Go back to the Graph menu and select Histogram
• Select Simple
• Click inside the Graph Variables dialog box > select T1-Distance, T2-Distance,         

T3-Distance, T4-Distance, and T5-Distance
• Click the Labels button.  Select the Data Labels tab and check Use y-value labels
• Click OK twice
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Histograms

RESULTS:
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TASK: Plot all five histograms in separate panels of a single chart:
• On the toolbar click the icon “Bring up last dialog box” (#9) or use “Control-E”

• Select Multiple Graphs button>Multiple Variables tab
• Select “In separate panels of the same graph” and check “Same Y”
• Click OK twice

Time Plot: Stratified
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Histograms

RESULTS:
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Dot Plots

TASK: Make Dot Plots of all five teams distances:
• Go to Graph menu > Dotplot
• Select Multiple Ys Simple - Click OK
• Click inside the Graph Variables dialog box. Select T1-Distance,    

T2-Distance,T3-Distance, T4-Distance, and T5-Distance
• Click OK
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Dot Plots

RESULTS:
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Histograms and Dot Plots

TASK: Alternate way to get histograms and dot plots in Minitab:
• Go to Stat menu > Basic Statistics > Display Descriptive Statistics
• Click in the Variables box and select T1-Distance, T2-Distance, T3-Distance, 

T4-Distance, and T5-Distance
• Click on Graphs. Check Histograms of data, with normal curve
• Click OK twice
• Minitab displays the descriptive statistics in the Session window and the 

graphs in their own windows
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Histograms and Dot Plots

RESULTS:

Variable N N* Mean SE Mean StDev Minimum Q1 Median Q3
T1-Distance 20 0 133.75 3.15 14.07 112 120.25 134 146.25
T2-Distance 20 0 19.7 0.242 1.081 18 19 19.5 20.75
T3-Distance 20 0 89.4 2.77 12.41 49 86.5 93 96.75
T4-Distance 20 0 98.38 1.58 7.08 79 92.5 102 103.38
T5-Distance 20 0 123.3 1.98 8.87 97 119.25 123 129.75

Variable Maximum
T1-Distance 156
T2-Distance 22
T3-Distance 104
T4-Distance 104
T5-Distance 137
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Boxplots

Definition: Box plots summarize data in percentages (%) using the  
Median (not the Mean!)

50
Outliers

Top wisker (76 - 100%)
40

Top box (51 - 75%)
30

20 Bottom box (26 - 50%)

10
Bottom whisker (0 - 25%)

0

*

*

Series

Median

First quartile

Third quartile

Top whisker (76-100%)
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Boxplots

TASK: Make Dot Plots of T1-Distance, T2-Distance, T3-Distance,        
T4-Distance, and T5-Distance:

• Go to Graph menu > Boxplot
• Select Multiple Ys Simple > Click OK
• Click in the Variables box and select T1-Distance, T2-Distance,T3-Distance,        

T4-Distance, and T5-Distance
• Click OK twice
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Boxplots

RESULTS:
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Boxplots

TASK: Display difference between the pass (P) and fail (F) for T1-Distance:
• Go to Graph menu > Boxplot
• Select Multiple Ys with Groups
• Click in the Variables box and select T1-Distance
• Click inside Categorical variables for grouping > select T1-Pass/Fail
• Click OK
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Boxplots

RESULTS:
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Boxplots

TASK: Display the mean symbol on 
the boxplots

• Go to the Add List selector in the
Graph Editing Toolbar

• Select Data Display
• Check the Mean Symbol box
• Click OK
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Scatter Plots

• To create scatter plots we need to 
related numerical variables.  Therefore 
we need to add the Variation data for 
Teams 2 and 3:

Go to the worksheet and click on the 
first cell of column C8 (T2-Variation)

Input the data as shown in the picture 
to the right

Do the same for column C11
(T3-Variation)

Definition: Shows relationships between numerical variables
(NOT non-numeric variables!)
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Scatter Plots

TASK: Create a graph showing the relationship between 
the Distance and the Variation for Teams 2 and 3:

• Go to Graph menu > Scatterplot
• Select Simple
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Scatter Plots

• Select T2-Variation for the 1st Y variable

• Select T2-Distances Volume for the 1st X variable

• Select T3-Variation column for the 2nd Y variable

• Select T3-Distance Volume column for the 2nd X variable

• Click on Multiple Graphs

• Select Overlaid on the same graph

(Cont...)
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Scatter Plots

RESULTS:
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Scatter Plots

Go to the worksheet and right 
mouse click on the title         
cell of column C1-D

Select Insert Columns

Title the new column        
“Team Member”

Input the data as shown in the 
picture to the right

TASK: Create a stratified graph showing the relationship between the 
Distance and the Variation for Teams 2 and 3 for each “Team 
Member”:

• Assume each team has four (4) members and that each team member 
performed five (5) launches:
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Scatter Plots: Stratified

• Go to Graph menu > Scatterplot

• Select With Groups

• Select T2-Variation for the 1st Y variable

• Select T2-Distances Volume for the 1st X variable

• Select T3-Variation column for the 2nd Y variable

• Select T3-Distance Volume column for the 2nd X variable

• Click inside the Categorical variables for grouping box and select 
Team Member column (C1)
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Scatter Plots: Stratified

• Click on Multiple Graphs
• Select Overlaid on the same graph
• Check Same Y
• Click OK twice

(Cont...)
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Scatter Plots: Stratified

RESULTS:
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Pareto Charts

• Open ACTION_REQUEST_PARETO.MTW worksheet

Go to File > Open Worksheet

Search for file and open it

• This worksheet contains 500 trouble ticket requests by category

Definition: A bar chart that shows number of occurrences in descending 
order as well as the cumulative percentage of the data



OSD Greenbelt - UNCLASSIFIED 216

Lean Six Sigma

UNCLASSIFIED

OSD, Business Transformation L6σ Green Belt Training
431 UNCLASSIFIED

Pareto Charts

TASK: Create a Pareto Chart using the Type data in column C2-T:
• Go to Stat menu > Quality Tools > Pareto Chart

• Click inside the “Chart defects data in:” selection box and select the Type
column 

• Click OK
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Pareto Charts

RESULTS:

Count 132 108 83 72 34 25 25 21
Percent 26.4 21.6 16.6 14.4 6.8 5.0 5.0 4.2
Cum % 26.4 48.0 64.6 79.0 85.8 90.8 95.8 100.0
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Pareto Charts

TASK: Get a summary table of the Types and Counts:
• Go to Stat menu > Tables >Tally Individual Variables

RESULTS:
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Pareto Charts

TASK: Get a Pareto from the table in columns C4-T and C5:
• Go to Stat menu > Quality Tools > Pareto Chart
• Click the “Chart defects table”
• Select Type-2 for Labels and Total for Frequencies
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Pareto ChartsPareto Charts

RESULTS:

Count 132 108 83 72 34 25 25 21
Percent 26.4 21.6 16.6 14.4 6.8 5.0 5.0 4.2
Cum % 26.4 48.0 64.6 79.0 85.8 90.8 95.8 100.0
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Control Charts

• Go back to the catapult data worksheet
• Go to Stat menu > Control Charts > Variables Charts for Individuals > Individuals
• Click inside the Variables dialog box > select T1-Distance

Definition: A Time Series plot that shows control limits at both +3σ
and -3σ from the mean
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Control Charts

RESULTS:
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Control Charts

TASK: Remake plot with separate control limits for each team member:
• On the toolbar click the icon “Bring up last dialog box” (#9) or use “Control-E”

• Click on I Chart Options > Go to Stages tab

• Click on the Define Stages box > select Team Member

• Click OK twice
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Control Charts

RESULTS:
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Work 
Sheets
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The Six Sigma Tollgate ToolThe Six Sigma Tollgate Tool

Project Charter
Problem Statement
Defined Benefits
Business Case

Process Map Potential Xs “To Be” Process Map Transition Plan

Measurable Y
Customer Specs/VOC

Data Collection Plan
Data Collected

Critical Xs Improvement Strategy
Improvement Model
“X” Improvement Target

QC Chart

Cross Functional Team Data Presentation
Run Chart; Histogram; 

Mean/Stand. Dev.

Required Data Display:
Pareto Charts; Fish 

Bone / C&E; Histograms; 

Mistake-Proofing Communication to 
Impacted Areas

Timeline Updated CTQs/CTPs Optional Data Display: 
Descriptive Stats.; 

Time Series Plots; 
Control Charts; Box Plots

FMEA Project Documentation

SIPOC “Y” Performance Target XY Matrix Risk Analysis & Risk 
Mitigation Plan

I accept the Define 
Tollgate. Signed:

I accept the Measure
Tollgate. Signed:

I accept the Analyze 
Tollgate. Signed:

I accept the Improve 
Tollgate. Signed:

I accept the Control
Tollgate. Signed:

(Sponsor) (Sponsor) (Sponsor) (Sponsor) (Sponsor)

(Process Owner) (Process Owner) (Process Owner) (Process Owner) (Process Owner)

(MBB) (MBB) (MBB) (MBB) (MBB)

(Finance Owner) (Finance Owner) (Finance Owner)

Define Measure Analyze Improve Control

- A -
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Charter & TimelineCharter & Timeline

Charter
Problem 
Statement:

Business 
Case:

Unit:

Customer 
Specifications:

Measure Stop:
Measure Start:

Defect:

Scope:

Timeline
Phase Planned Actual Status

Define dd mm yy dd mm yy

Measure dd mm yy

Analyze dd mm yy

Improve dd mm yy

Control dd mm yy

Take away 
message goes 

here
(impact of 
problem)
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Project Action Item RegisterProject Action Item Register

PROJECT DESCRIPTION LEAD RESOURCES PROBLEM STATEMENT
NATURE OF 

DEFECT CORRECTIVE ACTION PLAN DUE DATE PROGRESS
DATE 

UPDATED

Calibrate temperature control 
system on all units. John Doe

Supplier
Ellen Technician

Independent measures of ink 
temperature do not match those on 
the consol. Each is off by different 
amounts. 

Variant temps 
between the units 
causing print 
defects.

John will contact supplier re: 
problem, Ellen will use manual to 
attempt to reset control system 
and calibrate. 12/14/1999

Completed 
11/29/99 11/29/1999
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Exercise: Catapult PerformanceExercise: Catapult Performance

Group # Name

Test Launch

Distance 1

Variance from Center 1

Distance 2

Variance from Center 2

Distance 3

Variance from Center 3

Distance 4

Variance from Center 4

Distance 5

Variance from Center 5

Total

Mean/Average

Median

Sigma
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Exercise: Catapult PerformanceExercise: Catapult Performance

Group # Name

Test Launch

Distance 1

Variance from Center 1

Distance 2

Variance from Center 2

Distance 3

Variance from Center 3

Distance 4

Variance from Center 4

Distance 5

Variance from Center 5

Total

Mean/Average

Median

Sigma
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Implementation PlanImplementation Plan

DACI
Task

Driver Approver Contributor Informed

Identifying solutions

Selecting Solutions

Planning the 
implementation

Handling potential 
problems

Implementing the 
solution

Monitoring results
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GREEN BELT ACRONYMSGREEN BELT ACRONYMS

µ Population mean (mu) mR Chart Moving Range

5S Sort - Set in Order - Shine - Standardize - Sustain MSA Measurement Systems Analysis

6Ms
Manpower, Machines, Materials, Measurements, 
Methods, Mother Nature mXbar Chart Moving Average

6S 
Sort - Set in Order - Shine - Safety - Standardize - 
Sustain nP Chart Number (control) chart

AIR Action Item Register NVA Non-Value-Added
C Chart Count (control) Chart P Chart Proportions (control) chart
CPI Continuous Process Improvement PPM Parts per million
CTQ Critical to Quality r Correlation Coefficient

DACI Driver Approver Contributor Informed RPN
Risk Priority Number.  The product of 
Sev*Occ*Det.  Used in FMEA.

DMAIC Define, Measure, Analyze, Improve, Control RTY Rolled throughput yield

DPMO Defects Per Million Opportunities s
Sample standard deviation.  Estimate of the 
true σ.

DPU Defects Per Unit SOP Standard Operating Procedures

FMEA Failure Modes and Effects Analysis SIPOC
Suppliers Inputs Process Outputs 
Customers

Gage R&R Gage Repeatability & Reproducibility U Chart Rate (control chart)
GB Green Belt UCL Upper Control Limit
I/MR Chart Individual / Moving Range USL Upper Specification Limit
JIT Just-in-time VA Value-Added
KPI Key Process Indicator VOC Voice of Customer
LCL Lower Control Limit X-bar Sample mean
LSL Lower Specification Limit Xi Individual data point

LSS Lean Six Sigma Y=f(x) Outputs (Y) are a function of the Inputs (x).
MBB Master Black Belt σ Population standard deviation (sigma)




